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Micro Focus Enterprise Developer 5.0 for
Eclipse Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

i Note:

» This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

» Check the Product Documentation section of the Micro Focus SupportLine Web site for any
updates to the documentation which might have been uploaded.

Product Overview

Enterprise Developer supports IBM COBOL, IBM PL/I, IBM Assembler, IBM CICS, IBM IMS, IBM JCL, IBM
DB2, IBM z/OS file formats and common batch utilities, including SORT. This means that you can develop
and maintain the core mainframe online and batch applications under Enterprise Developer. You can then
deploy these applications back on the mainframe or migrate them onto one of the Micro Focus Linux, UNIX
or Windows-based production platforms.

The Application Workflow Manager section in General Reference explains the mainframe integration and
mainframe modelling features of Enterprise Developer for z Systems.

i Note:

» The Application Workflow Manager is available within all Enterprise Developer variants and
provides all the capabilities and tools to develop and maintain Application Workflow models. These
models allow you to integrate tools and processes directly into Enterprise Developer. You can use
the Application Workflow Manager with the following products:

« Enterprise Developer - the Enterprise Developer setup file automatically installs the Application
Workflow Manager.

» IBM Rational Developer for System z (IDz) - see Installing Application Workflow Manager into
Rational Developer for System z (IDz) in the installation instructions. This requires that
Enterprise Developer Connect is installed and licensed.

Upgrading from earlier Micro Focus products
i Note: Windows-only.

This version of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with a version earlier than 4.0
might not be compatible with the current version of the run-time products. If the behavior of your application
changes with the current version, we strongly recommend that you relink the main executable with the
current version. This will ensure that the COBOL run-time system fully handles any run-time error
conditions that might occur.

A new executable that is fully compatible with the current version can be produced without recompiling the
application, as long as the original object code is available and it is relinked with the current version.

To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.

Micro Focus Enterprise Developer 5.0 for Eclipse Release Notes | 5
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If you are using Eclipse, Enterprise Developer can automatically relink existing projects created with
Enterprise Developer earlier than 4.0 that have executable link artefacts. Eclipse displays a warning in the
Problems view that the project requires relinking. It then offers a Quick Fix action for you to execute that
will link your project with the most recent version of the Run-Time System.
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What's New

This release provides enhancements in the following areas:

e Amazon Web Services Quick Start for Enterprise Server
e COBOL Formatting

e Code Analysis

» Enterprise Server and Scale Out Architecture
« Enterprise Server Common Web Administration
* Application Workflow Manager

* AppMaster Builder

¢ CICS Support

e COBOL Language Enhancements

e Compiler Directives

» Consolidated Trace Facility

» Data File Tools

» Database Access

» Debugging

« Eclipse Integration

» Enterprise Server Security

¢ IMS Support

e JCL Support

¢ Mainframe Access

» Micro Focus Native Database File Handler

e Micro Focus Rumba

e Micro Focus Unit Testing Framework

e PL/I Support

e Platform Support

* Product Documentation

Amazon Web Services Quick Start for Enterprise Server
Back to Top

Micro Focus has worked with Amazon Web Services (AWS) to create an AWS Quick Start for Enterprise
Server. The Quick Start includes AWS CloudFormation templates and a deployment guide with step-by-
step instructions that enable you to deploy Enterprise Server into a hew or existing virtual private cloud
(VPC) on the AWS Cloud in about 1 hour and 15 minutes.

For full information see Micro Focus Enterprise Server on AWS (click here).

COBOL Formatting

Back to Top

You can now reformat your COBOL code in the editor according to your preference and standards.
Formatting sets the indentation based on the configuration options which you can set in Windows >
Preferences > Micro Focus > COBOL > Editor > Formatter (for Eclipse).

You can find the COBOL formatting features on the editor context menu (for Eclipse) menu.

What's New | 7
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Code Analysis

Back to Top
You can now create the following views for your code:

* Program Flow Graph - enables you to view the overall structure of the COBOL program with nodes
representing sections and paragraphs. PERFORM statements between them which affect the program
flow are represented by links joining the nodes. External calls to other programs are shown but cannot
be expanded in the Program Flow Graph view. Hovering over the nodes shows a tooltip containing the
code representing the respective sections or paragraph. Clicking a node or a link joining said nodes
positions the code editor to that point in the source, allowing quick and easy navigation of the program.

- Data Flow Analysis Tree - enables you to select a data item and then either statically trace what might
change its value or what other data items it might affect.

Enterprise Server and Scale Out Architecture

Back to Top
f Note: This feature is in Early Adopter Product (EAP) release status.

This release offers an enhanced and improved availability, and serviceability of Enterprise Server through
the ability to administer and maintain a cross-system group of regions as a single system image with the
new Performance and Availability Cluster (PAC).

In order for different Enterprise Server instances to be able to work together, they need to be able to share
data. This is achieved through the use of a Scale Out Repository (SOR). All ES instances in a PAC will
have a common SOR (PSOR) which is used to store CICS resources (limited to PCTs, PPTs, FCTs, DCTs
and TSTs in this release) as well as internal system data to facilitate synchronisation between instances.
Temporary Storage Queues and Transient Data Queues can also be shared between Enterprise Server
instances by directing them to a SOR. Benefits of using PACs and SORs in this way include:

* Reduced hardware costs - taking advantage of the PAC to scale-out rather than scaling-up for more
efficient use of processor resources.

» Easier maintenance - Dynamically adding or removing of regions to the PAC for system maintenance.

« Increased availability - in the event of the failure of an Enterprise Server instance, the PAC can continue
to operate with reduced capacity. Enterprise Server instances can reside on different machines,
improving availability further.

« Dynamic scaling - Enterprise Server instances can be added to, or removed from, the PAC depending
on demand.

» Better performance - throughput is no longer restricted by the resources on a single machine (scale-up).

« Improved serviceability - you can now administer the PAC and any associated regions as a single image
from a new contemporary web-based administration interface (ESCWA).

Enterprise Server Common Web Administration

8 | What's New

Back to Top
f Note: This feature is in Early Adopter Product (EAP) release status.

Enterprise Developer now includes a new Enterprise Server Common Web Administration interface
(ESCWA). ESCWA is a web user interface and server for modern administration, monitoring and control of
Enterprise Server. It offers improved usability that consolidates the different Enterprise Server user



interfaces so that native and managed regions, and security stores can be managed in one place. Features
include:

Administering directory servers across multiple hosts.

Monitoring and control of CICS and JES Enterprise Server instances.

Configuring and administering a security store, defined in an LDAP-compatible security manager such
as Microsoft Active Directory or OpenLDAP.

Administering the Scale-Out features - enable you to specify logical groups of Enterprise Server
instances, and configure and run Performance Availability Clusters (PACs) and their related Scale-Out
Repositories (SORS).

Administering, monitoring and control of Enterprise Server for .NET regions and listeners.

The use of current web frameworks that have a greater focus on security.

(Included with 5.0 Patch Update 2 ) - support for Enterprise Server XA, MQ and PL/I configuration and
monitoring. This includes support for XA resources, configuring MQ, Listeners and Writers, PL/I, MFCS
console, Region Trace options, displaying the current ESMs on logon page and Local/loopback
connections warning changes.

Application Workflow Manager

Back to Top

Improvements have been made in the following areas:

Tools from the AWM, Eclipse, and ISPF Function Packages have been restructured and improved:

» Tool parameters are now named so that the position of the parameter is not significant anymore.

* You can only specify parameters which are supported by the tool.

e Only the parameter types String and File are now supported.

« Mass Processing is now an attribute of a tool parameter and is no longer a special input/output
parameter type.

* The tool relationship "Resource Operation Value" replaces the parameter type
"ToolDefinedResourceOperation".

A new REST Function Package has been added. It provides support for the following functions -

DELETE, HEAD, GET, PATCH, POST, and PUT.

The new JSON File Descriptor has been provided to support REST payloads. This function package
enables you to integrate RESTful API with your AWM workflow. See REST Function Package in your
product Help.

New tools in the Eclipse Function Package enable you to store and retrieve information from the Eclipse
secure store:

e Save To Secure Storage; Read From Secure Storage; Delete From Secure Storage

You can use these tools to securely store login credentials to a remote system and reuse the
information for subsequent access.

A new attribute is now available to enable you to add comments to every model component in the AWM
model editor. See Comments in the AWM Model Editor in your product Help.

AppMaster Builder

Back to Top

The AppMaster Builder Data View Explorer tab has been redesigned in this release make it easier to
create and maintain data views. Features include:

Creating SQL data views directly from the mainframe DB2 catalog

What's New
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* Creating IMS and VSAM data views without the requirement for a global DDIFILE
» Generating data views using new DDIMETA files located in the DDIMETA folder in the AMB project
« A data view import process is provided to create DDIMETA files from existing DDISYMB files

CICS Support

Back to Top
f Note: This feature is in Early Adopter Product (EAP) release status.

This release includes the following enhancements:

* CRCN CICS transaction - this new in-built CICS transaction monitors the state of XA connections for
each resource manager (RM) entry defined in the system. If CRCN finds that connections have become
unavailable, it will attempt to reconnect at regular intervals. (The frequency of the monitoring is
controlled by the ES_XA_RECONNECT environment variable.) CRCN will emit messages to the
console to warn of connections lost and regained.

COBOL Language Enhancements

Back to Top
The following enhancements have been made to the COBOL syntax:

* 1S02002 conditional compilation - an additional mechanism for conditional compilation, the 1ISO2002
Conditional Compilation method, is now available. This has been implemented as part of the support for
Enterprise COBOL 6.2.

The following compiler directing statements are supported:
>>DEFINE

>>|F/>>ELSE/>>END-IF

>>EVALUATE/>>WHEN/>>WHEN OTHER/>>END-EVALUATE

« The JSON PARSE statement enables you to convert JSON text into COBOL data formats. This has
been implemented as part of the support for Enterprise COBOL 6.2.

e INSPECT statement - the performance of INSPECT... CONVERTING has been improved, particularly
for cases where source-alphabet is long.

e Support has been added for the portable syntax for SET - set[string].

Compiler Directives
Back to Top

The following Compiler directives are new in this release:

JVMTARGET Specifies the JVM version number targeted by the class files generated in this
compilation unit.

ILNORMALIZENAMES Determines the program elements that are normalized when a program is
compiled to .NET or JVM COBOL. Normalization in this context results in
replacing all $ and - (hyphen) characters with _ (underscore) characters in the
name of the generated class file.

10 | What's New



Consolidated Trace Facility (CTF)

Back to Top

This release provides the following enhancements:

Availability of CTF from the Eclipse interface - a new property tab, CTF, in the Eclipse launch
configuration dialog box helps to enable CTF tracing and specify a CTF configuration file. By default, the
trace files are then saved in a Logs subfolder within the project's folder.

Dynamic CTF - it is now possible to configure the CTF dynamically from outside the process being
traced. This feature is only currently available on Windows platforms.

Using a new command line utility - cblctd - you can alter the tracing events of running applications
that already have CTF tracing enabled. You can alter trace levels, add or remove components to or from
the trace, and also configure the emitters in effect.

Additionally, there is also a new component that you can trace - mf.mfdbfh enables you to trace activity
of the Micro Focus Native Database File Handler.

Data File Tools
Back to Top

This release provides the following enhancements:

The Data File Editor now includes a Compare Files tool that enables you to compare the contents of
two data files side-by-side.

Structure files, and the layouts within them, can now be created within the Data File Editor; you no
longer need to use the Classic Data File Tools utility to manage your layouts.

When connecting to a VSAM dataset stored in an enterprise server region, you can store any
passwords required for access, for the duration of your current session.

You can view archived JES spool jobs that have been merged into one spool file using the merging
archived spool files process.

You can now quickly duplicate records in non-indexed files, using the Duplicate Record option.

Database Access
Back to Top

Enhancements are available in the following areas:

SQL Option for DB2

XML data type support - the following XML scalar functions are now supported - XMLATTRIBUTES,
XMLCOMMENT (add), XMLCONCAT, XMLDOCUMENT, XMLELEMENT, XMLAGG(delete),
XMLNAMESPACES, XMLPARSE, XMLPI, XMLSERIALIZE, XMLTEXT, XMLQUERY.

Initial XDB Server (add) support for z/OS DB2 V11 - includes support for archive tables and ALIAS on
sequences (delete).

XDB Link support for z/OS DB2 V10/V11/V12 (add)

Debugging

Back to Top

What's New
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This release includes the following enhancements:

Animate - Eclipse now includes an additional menu option when debugging a COBOL program for
setting the speed and toggling Animate mode. When active, the program will automatically step through
each line of source code, updating the source code in the editor, the Debug Stack, Outline and
Variables Views. See Debugging Commands and Options in your product Help.

Conditional watchpoints - you can now specify conditions and hit counts for COBOL watchpoints. A
condition can be in the form of an expression or it can be a hit count (for the number of times memory
associated with a data item has been updated). The condition is evaluated each time the data item
being watched changes. If the condition evaluates to true, then program execution stops. This enables
more fine-tuning of the current watchpoint support and is useful when debugging large, complex
programs.

Dynamic core dumps - you can now invoke a core dump programmatically and continue execution of
your program. A new library routine, CBL_CREATE_CORE, enables you to produce a core file for the
current process or a process owned by the same user that owns the current process.

Improved visibility of the PERFORM stack - the PERFORM stack and PERFORM range names are
visible in system debuggers such as gdb in many cases on 32-bit Linux with Intel architecture and
Solaris with Intel architecture. This was already the case on AlX, 64-bit Solaris-Intel, and all other Linux
platforms (including 64-bit Linux-Intel).

In order to include source line numbers in run-time error messages, which makes the diagnosis of
issues in your program easier, the COBOL compiler now produces . idy files by default when building
from the command line, unless the NOANIM directive is specified. You can safely remove . idy files
after compilation if you do not need them; they do not need to be distributed with your application unless
you want to debug your code. However, unless you specify the ANIM directive, generated executables
such as .dll and .gnt will not be debuggable, which is consistent with prior behavior.

f Note: Behavior has not changed if you are using an IDE or build scripts generated by an IDE.

Stackdump files (Linux Intel 64-bit, Solaris Intel 64-bit, and Linux/390 platforms only) - you can produce
a stack trace for applications in a production environment that encounter a Run-Time system error. Use
the stackdump_on_error and stackdump_filename tunables to configure the production of a stackdump
file when an error occurs, from which you can locate the exact line of failing code in your program.

A new configurable tool is now available that dumps to a file stack traces of all threads in process on
any Run-Time System error. [Linux Intel, Solaris Intel, zLinux only — requires ANIM on 32-bit Linux
Intel]. This is only supported for native COBOL.

Line number information is now being output for optimized builds (on Linux Intel 64-bit, Solaris Intel 64-
bit, PowerLinux, zLinux, and Solaris SPARC platforms only). This is only supported for native COBOL.
Because of what optimization does, the information is imperfect, but it remains highly indicative. This
gives the following advantages:

« Enables the use of the stackdump utility (where available) for optimised builds.
* Provides location information should a signal occur when running in a system debugger such as gdb.
« Provides some limited ability to step through optimized code in system debuggers.

Eclipse Integration
Back to Top
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This release includes enhancements in the following areas:

Supported Eclipse versions - this release supports Eclipse 4.7 (Oxygen) and 4.8 (Photon). The setup
file installs Eclipse 4.8.

Eclipse 4.6 (Neon) is no longer supported.



Java support - the 64-bit Java 8 is required to run the Eclipse IDE. The setup file installs Adopt
OpenJDK 8 (u202) with Hotspot. Java 8 (32 or 64-bit versions), and Java 11 (64-bit version only) are
supported for executing JVM COBOL code and for native COBOL and Java interoperability. For full
details on the supported Java versions, see Software Requirements in your product Help.

COBOL editor:

» Automatic insertion of END statements - Eclipse nhow automatically inserts the end clause for IF,
EVALUATE, PERFORM, EXEC and TRY statements.

< Automatic insertion of closing symbols - by default, Eclipse now automatically adds closing quotes
and brackets where required.

» Search text positioned between specified columns - the Micro Focus Find/Replace dialog box now
includes options to search between specified columns in the code.

Directive sets - Compiler directives for your projects are now saved in language-specific .mfdirset

XML files stored within a . settings subfolder in the project's folder. You can create your own versions

of _.mFdirset files and verify them against an XML schema that Micro Focus supplies.

Previously, all settings were stored in a single, proprietary IDE project file. Existing projects which
currently specify directives and other similar settings in the .cobolproj file will be upgraded to use the
new .mfdirset files when imported or loaded in Enterprise Developer 5.0. If you are storing your
source code in a source control system, ensure that you add the .mFfdirset files to source control as
well.

Remote connections - support is available for automatic SSH tunnelling of Micro Focus Enterprise
Developer UNIX Components network traffic. You can route most Micro Focus Enterprise Developer
UNIX Components network traffic using SSH port forwarding. This makes developing on a remote UNIX
host running a firewall easier to configure. In addition, the network traffic is encrypted as it is being sent
within an SSH tunnel. See To create a connection to a remote UNIX host running behind a firewall in the
product Help.

User Interface:

« The COBOL Explorer view uses an icon overlaid with P to indicate COBOL programs that will not
be built because they are preceded by another of the same name on the build path.

* Improved settings Ul - the COBOL, IMS, and the Run-time Configuration settings pages now use a
property grid that also shows the definitions of the settings.

Enterprise Server Security
Back to Top

This release includes the following enhancements:

Security - security features can now be employed when developers and administrators install new
COBOL services (web services and EJBs) into an enterprise server instance over the network. There
are a number of authentication and authorization options that can be enabled. See Deployment
Listeners and The .mfdeploy File in your product Help.

Vault Facility - a new security feature has been added that enables some Enterprise Server components
to keep certain sensitive information in a form of storage defined as a vault, accessible via a
configurable vault provider. The default vault provider stores data in encrypted format on disk.

OpenSSL 1.1.1 - the OpenSSL security provider has been updated to OpenSSL version 1.1.1.
This is the stable Long Term Support version of OpenSSL.
» Added support for the ratified TLS protocol version 1.3. TLS 1.3 benefits include:

* Much shorter initial connection negotiation sequence. This reduces the time taken to establish a
link before starting to transmit data.

< Using only the most secure ciphers and hash methods.
e TLS 1.3 will be negotiated in preference to the older TLS protocols.

What's New | 13



« Added support for new Ciphers and Key Exchange groups in line with TLS 1.3 requirements.

» The default security level for previously configured endpoints has been moved from Security Level O
to Security Level 1. This removes the ability to accidentally make use of known-weak elements such
as SSL3 and MD5. Similar changes to the default Security Level have recently happened to Java,
Chrome, Firefox, and other systems providing secure connections.

Fileshare Security - the Fileshare Secure TCP/IP transport provider now supports the trusted use of

X509 certificates bearing the name of the Fileshare service as the Common Name element of the

certificate.

In previous releases, a secure connection to a Fileshare server was made using a certificate that
represented the network location upon which the Fileshare service was located. This method is still
supported, but does not distinguish between the exact Fileshare server that is being connected to when
more than one service can exist on a single host system. With this change, individual Fileshare services
can identify themselves by using a unigue certificate. While running on the same host and registered
with the same network endpoint.

Support for Active Directory user groups and group name mapping - the Enterprise Server External
Security Facility's MLDAP ESM Module can now use Active Directory user group objects for Enterprise
Server user groups. Also, the module can now map long group names to the 8-character-maximum
names required for mainframe emulation.

Selective auditing - administrators can audit only security activity of particular interest, reducing audit
overhead and the volume of events. The Enterprise Server External Security Facility's MLDAP ESM
Module can now enable ESF Audit events only for particular users, groups, and resources.

Improved interaction with LDAP client libraries resulting in fewer LDAP-related issues and easier
diagnostics - the Enterprise Server External Security Facility's MLDAP ESM Module has improved
interoperation with LDAP client libraries:

e The client library vendor and version information is logged after the library is loaded

« The module has better heuristics for loading the correct library supplied by the OS vendor, so the
"provider" configuration option can generally be omitted

* For OpenLDAP, the module sets its proprietary "connect timeout" option

SNI support (requires 5.0 Patch Update 1 or later) - support has been added in Patch Update 1 for the

Server Name Identification (SNI) extension to TLS. This helps to avoid connectivity issues related to a

growing number of Web services being hosted on SNI servers.

IMS Support

Back to Top

This release includes the following new feature:

Checkpoint and restart are now available for output GSAM files in addition to input GSAM files.

JCL Support

Back to Top
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This release includes the following enhancements:

Spool file housekeeping - you can now merge your archived spool files to a central location where they
can be viewed using the Micro Focus Data File Editor. This copies the archived spool files and merges
them into a new, combined archive. It does not change the original archive, so the audit trail remains
untouched, but the combined archive allows viewing of all the jobs that have been merged. The merge
process is carried out using a JCL job or by using a command line utility.

A new user exit MFJFAXIT - this user exit allows you to receive naotifications when 'file open' events are
processed by the JCL engine. A sample exit can be found in the src\enterpriseserver\exits



sub-directory of your product install directory. You can enable this exit by using the MFIJFAXIT
environment variable, to point to the exit program.

Mainframe Access
Back to Top

This release provides enhancements in the following areas:

« Full support for the z/Server functionality - MFA Server now has the capability to service all z/Server
requests. This means it is no longer necessary to configure z/Server, and the number of started tasks
running on the mainframe is reduced. Installing and configuring MFA Server becomes easier as z/
Server is no longer required.

» Browse dataset using IDCAMS dump - when using the MFDAS BROWSE command, it is now possible
to view the output of the IDCAMS DUMP command on the specified dataset in hex and printable
characters side-by-side.

» Improved JES support for executing jobs and input datasets - it is now possible for MFA Server to
interact with JES jobs that are in executing phase, and to list and download input datasets.

* Retrieve binder information for load modules - when executing the MFDAS BINDER command, it is now
possible to view the binder information from a load module.

e TSO command server - MFA Server includes a new type of application server to support executing TSO
commands as the current user. The address space is spawned as your user id and any valid TSO
command can be executed.

e UNIX sub-system (USS) support - MFA Server can now operate on files stored on a USS file system.
The available functions are - edit, browse, rename, delete, and copy USS files and directories.

Micro Focus Native Database File Handler

Back to Top
f Note: This feature is in Early Adopter Product (EAP) release status.

The Micro Focus Database File Handler (MFDBFH) is a file handler that enables your native CICS and
batch enterprise server applications to interact with data files and certain infrastructure files stored within a
database.

VSAM files may experience logical and/or physical corruption in the event of a hardware failure. This is due
to a single COBOL I-O operation consisting of multiple physical I-O operations. If all the physical I-O
operations that make up the COBOL I-O operation are not performed, the file can be left without integrity.
In previous releases you could guard against such occurrences with Fileshare and logging, but they
required some manual intervention and came with performance cost.

In this release, configuration options have been added that allow the I-O operations to be routed to an
RDBMS to take advantage of the availability and performance characteristics of the database. This can be
achieved with no changes required to the application. The file will be routed to the SQL database simply by
changing the filename prefix to sql ://.

Features include:

e CICS and batch Cobol file I-O can now be routed to an RDBMS with only simple configuration changes.
No application changes are required.

e Supports all Micro Focus file formats

» Files can be routed to an RDBMS on a file by file basis.

« Utilities are provided to enable data to be moved between disk files and RDBMS.

« Support for PostgreSQL 10.x, Amazon Aurora PostgreSQL, Db21, and MS SQL Server (on Windows
and Linux Intel)
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Micro Focus Rumba
Back to Top

This release comes with Micro Focus Rumba+ Desktop version 10 which you can choose to install with
Enterprise Developer. This will enable embedded Rumba support within the IDE.

Micro Focus Unit Testing Framework
Back to Top

This release provides support for the following functionality:

» Data-driven unit tests - a new type of test suited to testing data where values read from a source are
passed through the same tests.

» JCL unit tests - two types of test that interact with the JES engine on an enterprise server region. These
tests are run from the command line.

« Test output colorization - test output can now include basic colorization for supported terminal
emulations. This feature must be run from the command line.

PL/l Support

Back to Top
Enhancements are available in the following features:

« Code coverage in Eclipse - code coverage data can now be generated for PL/I programs in the Eclipse
IDE using the same mechanisms as for COBOL programs.

e Compiler:

e Full support for GET DATA.
¢ Built-in functions:

* New built-in functions - ALLOCATE, INDEXR, MEMCONVERT, MEMINDEX, ONCONDCOND,
PLIFREE, REM, REPLACEBY?2

¢ The HEX built-in function now matches its z/OS version.
« The PROCNAME and PROCEDURENAME functions used without trailing open/close parents.

* Allow the use of VALUE to initialize members of a PL/I Data Structure.

e Support for INONLY, NONASSIGNABLE attribute.

« Diagnostics when a supplied parameter to a call is larger than the entry declaration.

» Diagnostics when the Compiler detects that a loss of precision occurs as a result of operations on
FIXED DECIMAL operands.

e Compiler listings now provide additional information about arrays.

« OPTIONS(REORDER) is now parsed but ignored.

* *PROCESS OPT(TIME); is now supported.

» Support for larger concatenations when initializing variables or making assignments.

e Support for named constants of numeric PICTURE type in static structure dimensions and
initializations.

« Diagnostics when the concatenation of two strings results in a string that is larger than the target
variable.

1 Db2 support was introduced in the 5.0 Patch Update 2 release
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e Support for the DUMMY ALIGNED and DUMMY UNALIGNED arguments.
» Support for the XML case asis and XML case Upper.
« Diagnostics if code attempts to use bitwise operators on non-bit variables.

* (Added in 5.0 Patch Update 1) A new option, —-fdmaxp 15,31, has been added. With this one
specified, arithmetic operations with fixed decimal operands with precision <= 15 produce a result
with a maximum precision of 15. For arithmetic operations with fixed decimal operands with precision
<= 31, they produce a result with a maximum precision of 31.

The options —fdmaxp 15,15 and —fdmaxp 31,31 are allowed, and correspond to —fdmaxp 15 and —
fdmaxp 31, respectively.

« PL/I debugger in Eclipse:

» Variables surrounding current point of execution now displayed in Variables view.

« A Console view for PL/I programs that are being remotely debugged outside the control of Enterprise
Server, and in Eclipse.

- Data watchpoint setting using a variable declaration in the debugger.

* PLIDUMP now emits STATIC variables in addition to AUTOMATIC and Parameters when
documenting the callstack.

* The Macro preprocessor now supports %INSCAN and %XINSCAN.
« The EXEC preprocessor how supports the following:

e SQL statements embedded within PL/I packages

« The -maxmsg option for setting the maximum number of errors to be generated before terminating
the compilation

« Up to 4000 include files in a signal program
e PL/I Run-Time System - support is now available for:

e Optionally generating Windows "Mini-Dumps" or a Linux coredump off the back of a call to
PLIDUMP.

« Dynamic allocation of datasets using the TITLE option(s).
* Raising an ERROR condition when a called subroutine raises a COBOL RTS error.
» FILE variables can have differing DCB when used in differing contexts.

e STATIC FIXED BIN(31) variable accessed at open within the RECSIZE() attribute of the
ENVIRONMENT.

Platform Support
Back to Top
Support is now available for the following additional or updated operating systems:

e SUSE (Power) 11 SP3, 12
* Red Hat (Power) 7.2, 7.3
e Windows Server 2019

For a full list of supported platforms, check HTTPS://SUPPORTLINE.MICROFOCUS.COM/
PRODAVAIL.ASPX.

Product Documentation
Back to Top

The following is new in this release:
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» The Comparison of COBOL with Other Managed Languages document has been updated to reflect the
recent enhancements in the .NET and JVM COBOL support.
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Significant Changes in Behavior or Usage

This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).

e Common Communications Interface
e Communications Server

e Compiler

« Data Tools

« Documentation

» Eclipse IDE

» Enterprise Server

« Enterprise Server Auditing

« File Handling

« HCO for SQL Server

e IMS Support

* Interface Mapping Toolkit

e JCL Support

e Mainframe Access

« Micro Focus Batch Scheduler Integration
* Micro Focus Directory Server

e MFCRYPTLIB

e PL/l Support

* Request Packet Interface API

Common Communications Interface
Back to the list

» Certificate subject names are now correctly checked against the name the client is attempting to
connect to. Certificates registered to "localhost” should now work as expected.

* The default Cipher Suites List now includes @SECLEVEL=0. This indicates that backwards
compatibility with old certificates such as MD5 is to be retained. As a result of this change, you need to
review your use of the Cipher Suites List and of any old certificates.

e If using Micro Focus Common Client(MFCC) or Micro Focus Communications Server(MFCS) to connect
to a non-existent remote host, it was possible to create a connection to a server listening on the same
port on the local system. This is no longer possible and a bad address error is reported in the error logs.

« By default, in this and previous releases an SSL/TLS CCI client can trust a server which resides on an
IP address that is not an intended connection target. You can now specify the ssl_only_verify_literally
option in your CCLINI file to restrict the certificate check to improve security. See “CCITCP Security
Options in the CCLINI File” in your product Help for more information. When connecting to a non-CCl
protocol server, all clients perform strict certificate checking as the new default behavior

Communications Server

Back to the list

« Passphrases specified in the mf-server.dat file can now contain spaces.
2832222 (1100976)
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» Configuring MFCC when run under MFCS now works as expected.

Compiler
Back to the list

« The Search order has been updated, to allow the Compiler to find Java.

Data Tools
Back to the list

« Accessing a dataset through the Data File Editor now obtains a shared lock on Enterprise Server when
you open the file in shared mode.

3170479 (1115346)

Documentation
Back to the list

e The ANIM Compiler directive has changed its default when compiling from the command line on
Windows platforms. The default is now ANIM. (Compiling from the IDE still defaults to ANIM.)

* The validation of server certificates for TLS (also known as SSL) connections has been corrected. This
is likely to cause connection failures in cases where previously connections were incorrectly allowed.
For example, if Fileshare is secured with TLS, client applications must be configured to use the
hostname of the Fileshare server as it appears in the server's certificate. If the Micro Focus Directory
Server is secured with TLS, then MFDS clients, such as the casstart command-line utility, will need to
connect to it using a hostname that appears in the certificate MFDS is using. (Note that a certificate can
contain multiple hostnames.) Consult your Certification Authority administrator for more information.

3192497 (1117068)

Eclipse IDE
Back to the list

« In the Expressions view, there has been a change to the way that the number of characters displayed is
controlled. The Hex part now always displays the same number of characters as the raw data part (note
that Eclipse enforces the character limit, so the number entered by the user will include those used to
display the hex values). A maximum length entry of O is now correctly interpreted as "no limit".

3161694 (1114658)

« Eclipse now colorizes files that it will not build because they are preceded by other files of the same
name on the build path. The icon of such files is overlaid by an | or P and Eclipse shows a tooltip with
an explanation. This is to clarify the difference between this scenario and build-action-ignored.

3161416 (1114607)

* Micro Focus Find/Replace now provides a Column Scope group that enables you to limit searches
between columns. You can specify columns or alternatively you can search only in the main code area
for the file type open in the editor. By default, it searches in all columns.

3142899 (1112931)

« Compiler directives are now stored in .mfdirset files which can be specified for particular languages, at
project/config/folder/file level.

2853665 (1104556)

e By default, COBOL, COBOL JVM, and Mainframe COBOL Projects have the EXITPROGRAM"ANSI"
directive set in the Project Settings > COBOL Properties. This specifies that if the EXIT PROGRAM
statement is executed in a program that is not under the control of a calling program, it causes
execution of the program to continue with the next executable statement. See EXITPROGRAM in your
product Help for more information.
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« The COBOL JVM method breakpoint can now be toggled on the heading of the method.

» The Eclipse IDE has an improved user interface for settings. The COBOL, IMS, and the Run-time
Configuration settings pages now use a property grid that also displays the definitions of the settings.
As part of these changes the Output path, Target type, and Bitism are now specified in the project's
Link properties, click Micro Focus > Build Configurations > Link.

Enterprise Server
Back to the list

* A number of audit events now contain some additional information.
3140310 (1112666)

« Previously, the /x option of the CASRDTEX utility had been duplicated to drive XML output. This
prevented the export of transactions which was the original meaning of /x. To generate an XML export,
you must now specify the option /xm.

3180233 (1116108)

» casfhsf could hang when processing HSF files that contain records from tasks that ran in different
months.

3177385 (1115884)

« A new system transaction, CRCN, is now available to monitor the state of XA connections for each
resource manager (RM) entry defined in the system. CRCN is a replacement for the former XA
Reconnect facility that recycled SEPs on connection loss. The XA Reconnect facility was configured by
setting the ES_XA_RECONNECT environment variable. CRCN also uses this environment variable,
although its usage differs slightly. For more information see your product Help.

3174272 (1115727)

* On Windows, any casout and cassub messages are displayed on cassub and casout API invocation if
the environment variable ES_CAS_API is not set to "ON".

3160400 (1114458)

« A new environment variable, ES_SNATRC_DIR, is available for configuring the location of the SNA
traces written by IMB's communication manager. To ensure that the SNA trace files are written to a valid
directory, ES_SNATRC_DIR must be set before you start the region.

3173516 (1115523)

* When defining CICS term in ESMAC, if the terminal definition includes a user ID, Enterprise Server
honors the terminal user ID, and you can leave the User ID field blank. Caution: When the terminal
definition includes a user ID, this logs you into the terminal without password verification. Use with care!

3158468 (1114309)

Enterprise Server Auditing
Back to the list

« Auditing on big-endian platforms now correctly interprets numeric audit data.

File Handling
Back to the list
« RELFORMAT=MF|RM is now enabled for FOLDER and other filename tags.

3164916 (1114803)
e The SORT-CONTROL special register is now supported during a SORT statement.

3159740 (1114389)
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« To direct the handling of relative files to a particular file handler (either MF COBOL or RM/COBOL), use
the RELFORMAT=MF or RELFORMAT=RM configuration options within the [REL-DEFAULT] tag of the
EXTFH.CFG file. (The default is RELFORMAT=MF.)

3157247 (1114149)

* The FORMAT parameter is now correctly ignored when the format is explicitly set in the Include
statement. Also, an error is now returned if a numeric item is compared with a quoted value in an
Include statement.

3186371 (1116564)

e For MFJSORT, the SORT-EBCDIC instruction is now supported through the PARM parameter of an
EXEC statement.

3165343 (1114824)

« When reading continuation lines from SYSIN for MFJSORT, if line 1 breaks at column 71 with a
nonblank in column 72, and columns 2-15 of line 2 are blank, DFSORT continues on line 2 with
whatever character it finds in column 16 (blank or nonblank).

3159842 (1114565)

HCO for SQL Server

Back to the list

« HCOSS DB2 schema extraction has been updated to use the DB2 system default of EBCDIC SBCS
CCSID <value> for DB2 columns in tables with a CCSID value of 0 (zero, CHAR family types). This has
been done to appropriately handle the CCSID value for tables created using DB2 version 8 or earlier,

and that have been migrated to a newer version of DB2. In addition, HCOSS DDL generation maps
Euro collection sequences to the nearest match to a supported SQL Server collation sequence.

3163636 (1114937)

IMS Support
Back to the list

« A performance delay that occurred when rapidly writing checkpoint records to the IMSLOGR file has
been corrected by updating the method used to verify the uniqueness of the timestamp in the key.

3131126 (1112901)
« The IMS Support feature has been updated to support checkpoint/restart for output GSAM processing.

3107543 (1109558)

Interface Mapping Toolkit
Back to the list

« If you try to deploy a stateful EJB SVI from the Visual Studio IDE after unchecking the “Reuse container
after application termination” check box (in the Deployment Characteristics tab of the Runtime
Environment Configuration dialog box), you receive a warning message informing you that the “Reuse
container after application termination” setting will be set to true for the deployment in order to prevent
the crash. In the Eclipse IDE, the unchecking of this option will just be ignored, and the option re-
selected. A warning to not uncheck the option for stateful EJB SVIs is also displayed on the prior page
(to the dialog box).

2663812 (1090987)

« WSDL and JSON Schema files generated for bottom-up CICS Web services now include a
"maxLength" parameter for all string fields.

3175039 (1116241)
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JCL Support
Back to the list

» If the catalog properties of a data set are updated using MVSCATPB, and the data set is not opened
during the JCL step it is assigned to, then the updated catalog properties are not written at the end of
step disposition processing.

3186942 (1116611)

« When security is enabled and a JCL job includes either JOBLIB or STEPLIB entries, the system now
checks that the user has READ access to each of the Partition Datasets (PO). If the user does not have
the required access, the job abends with a COND CODE of S913.

3176759 (1115814)

e The DATACLAS and MGMTCLAS attributes are now applied to a DATASET when it is added to the
catalog and SMS support is enabled (MF_SMS=0N).

3174534 (1115630)
*« The DSNRLI reason-code value will be hexadecimal 0x00000000 when the return-code is zero. This is
a change from the previous value of decimal zero, '0000'.

3171133 (1115344)

*  MFFTP quote handling has been reworked to support IBM behavior. Filenames that contain spaces are
now required to be defined within double quotes ("). This change is required to support mainframe
hosted files, where single quotes (') will no longer append the user ID to start of the filename as the first
node.

3168300 (1115058)

e If JES security is enabled, when a JCL job is submitted that uses a PROC or INCLUDE file that is part
of a cataloged Partitioned Dataset (PO), READ access for the dataset will be checked, and if the user
does not have permission to read the dataset then an error will be reported.

3166921 (1114955)

« When restarting a job, the COND CODES for steps prior to the restart step will not be evaluated. This is
a change in the behavior where previously the values of the COND CODES from the previous run was
checked. You can revert to the old behavior by setting the environment variable
MFJ_ALL_STEP_CHECK=Y.

3163358 (1114688)

* The Spool Housekeeping history file, INDEXO, can now support 7-digit job numbering. A conversion
utility, MFHKHCOQV, is supplied to convert any existing dataset to the new format. Run this utility using
the sample JCL job CONVERT.JCL. Once converted, the newly formatted dataset supports both 5- and
7-digit job numbering. If you only use 5-digit job numbering, you do not need to run the conversion. See
the '"MVSSPLHK Spool Housekeeping Process' section in the Help for more information.

3162868 (1114648)

*  When performing an IEBCOPY to a partitioned data set (PDS), a check is now made to ensure that the
user has DATASET ALTER permission for the PDS.

3159837 (1114347)

e The DSNRLI functionality for the TERMINATE THREAD call has been improved so that it now calls
tx_end and then tx_close for a particular XA resource. A ROLLBACK call will not be issued prior to the
tx_close. If an error is returned from the tx_end function, it is reported back to the calling program as
return code 12, reason code 0X00F30093.

e Missing and incorrect key values in the MF_JCL_AUDIT event output have been corrected. Also, the
audit event code resulting from MF_JCL_AUDIT has also been changed from '2 1' to '5 5' to avoid
conflict with the same code being used by other components.

* For RISC-based systems when running JCL jobs, you might need to set COBMAINSTACK to a high
value such as 8000000.
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e Anissue resulting in a Run-Time System error "RTS 119 Name is not unique" when calling 'setenv' to
dynamically assign a dataset from a COBOL program on a UNIX platform has been resolved. The call
to "SETENV" must be made in uppercase characters.

Mainframe Access
Back to the list

e By default, VSAM files whose average LRECL are the same as the maximum LRECL are now treated
as Variable when generating a .PRO file. You can override this with the existing /FIXEDVSAM flag, or by
specifying a fixed VSAM import type (ESDS-FIXED, KSDS-FIXED, or RRDS-FIXED).

3181871 (1116216)

* SyncMon2 now uses the Endevor "Source Date" and "Source Time" information to determine if a file
has changed since the last synchronization.

3177475 (1115904)

Micro Focus Batch Scheduler Integration
Back to the list

« When using MFBSI, the message JES000020W (JOB number warning percentage exceeded) is now
correctly handled, and no longer results in an invalid MFBSIJCL 208 return-code (JCL error).

3186963 (1116620)

Micro Focus Directory Server
Back to the list

* The event codes for several MFDS audit points have changed.

* On Windows, by default, the Enterprise Server Administration Web interface can only be contacted
using the loopback address (localhost or 127.0.0.1). You can enable remote access to the Web
interface by turning off the loopback mode. See "Using the Loopback Address" in your product Help for
more information.

MFCRYPTLIB
Back to the list

« Passing an incorrect keyfile passphrase no longer results in receiving an RTS115 error in MFDS.
3181743 (1116186)

PL/l Support
Back to the list

e A problem with allocation of BASED, CONTROLLED, and AUTOMATIC structures has been corrected.
This problem was limited to structures where the last member field was of type BIT. Specifically, the
problem only occurred for BASED, CONTROLLED, and AUTOMATIC structures when the last member
field is of type BIT, resulting in incorrect code generation for BASED and CONTROLLED storage at the
point of allocation (i.e., an ALLOCATE statement), and for AUTOMATIC storage, incorrect stack frame
allocation for the declared structure. Naturally, any module affected by this problem needs to be
recompiled. To ensure that no problems arise, the user should identify all modules that use a structure
or structures where the last member is of type BIT, and recompile those modules. This applies to users
who have compiled code with versions of Enterprise Developer earlier than ED 4.0 HF 10. Note: BIT
means a bit-string of any length, including BIT(1). It does not apply to BIT ALIGNED.

3192381 (1117048)
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* The Open PL/I compiler now generates a W-Level diagnostic if a constant array dimension or extent is
of type CHAR or BIT. This is usually unintended coding.

« The macro preprocessor now supports the use of %INSCAN and %XINSCAN.
2880348 (1107310)

« Previously, if a condition prefix for STRINGRANGE was enabled and a STRINGRANGE condition
occurred, it was raised to ERROR after being processed. This no longer occurs.

3182428 (1116254)

e PLISAXA, PLISAXB, and PLISAXC processing has been enhanced to use ENTRY LIMITED functions
and procedures which utilize OPTIONS(BYVALUE).

3150969 (1113745)
e A problem causing the SQL pre-compiler to hang has been fixed.

3165345 (1114825)

e SQL is now supported in a PL/I PACKAGE. A SQLCA declaration (usually via include of SQLCA) in a
nested block (PROCEDURE or BEGIN)is not allowed. It is allowed only in the outermost block(s) or in a
PACKAGE.

3159844 (1114355)

* The PL/I Eclipse debugger now supports double-clicking in the left margin on a DCL line to set a watch
on the variable for the content to change during execution.

< The PL/I Eclipse debugger now supports displaying the current value of a variable by placing the cursor
over a variable name in the PL/I source.

Request Packet Interface API
Back to the list

* The default behaviour for TLS certificate Common Name (CN) matching has changed for release 5.0. It
now requires a strict match on the CN value or any Subject Alternate Name (SAN). For example,
127.0.0.1 and localhost are no longer implicitly equivalent, nor are hostname and its IP address or fully-
qualified domain name (FQDN) variants. When starting a region from the Enterprise Server
Administration Web interface, a resolved IP address is used for the casstart -m parameter value. A
resolved IP address is also used even if a hostname is specified on a command line startup.

To change this behavior and use a resolved hostname value (as determined by the machine TCP
configuration, for example, hosts file entries.) set the environment variable MFDS_DNS_RESOLVE=Y.
To use an unresolved string literal hostname, for example, a value explicitly passed in via the casstart —
m command line parameter, set MFDS_DNS_RESOLVE=N.

3194613 (1117203)
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Known Issues

Known Issues

Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

In Enterprise Developer 4.0 and 5.0, in an extremely small and limited set of cases, an issue could

occur with running older .NET executables and .dll, and older JVM .class files. This issue only occurred

if:

1. The application performs an IS NUMERIC condition test on a variable declared with USAGE
NATIONAL.

2. The application has been created with Enterprise Developer 3.0 or earlier, and executed in
Enterprise Developer 4.0 or 5.0.

In these rare cases, the IS NUMERIC test could provide the wrong answer. To resolve the issue, you
need to recompile any programs that uses this construct in Enterprise Developer 5.0.

Program that do not use NATIONAL data, or those that have already been recompiled in Enterprise
Developer 5.0 are not affected.

The COBOL editor might show incorrect error messages for a linked resource with file-specific COBOL
settings as the file settings are incorrectly ignored.

When breakpoints have previously been set in a remote PL/l program in Eclipse and a new debugging
session is started for a local PL/I program, the debugger will crash. The same issue occurs if previously
set breakpoints are present on a local PL/I project and a remote debug session is started.

To work around this you need to clear all previously set breakpoints in remote (local) projects before
starting a local (remote) debugger session. You can remove the breakpoints from the Breakpoints view
in the Debugger perspective.



Resolved Issues

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

* Adis

» Application Workflow Manager

« AppMaster Builder

e Assembler Support

e Character Animator

e Cob/Chbllink/Cblnames (32-bit PC)
* Codeset Support

e Communications Server

e Compiler
» Data Tools
» Debugging

« Dialog System

« Documentation

e Embedded HTML Pre-Processor
e Enterprise Server

« File Handling

* IBM Language Environment for OS/390 & VM Support
- IDE

e IMS Support

e JCL Support

« Interface Mapping Toolkit

» Licensing

« Mainframe Access

* Micro Focus Batch Scheduler Integration
e Micro Focus Common Client

* Micro Focus Directory Server

» Micro Focus Server Administrator
¢ OpenSSL

e PL/I Support

* Run-Time System

e Setup

e SQL: COBSQL

e SQL: HCO for DB2 LUW

e SQL: HCO for SQL Server

e SQL: MBDT Utilities

e SQL: OpenESQL

e SQL Option for DB2

*  Web Service Client

* XML Support

e Zz/Server

Adis
Back to the list
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 ERASE EOL no longer stops Keisen attributes being inherited when enabled by x"AF" function 81.

3169584 (1115178)

e ACCEPT LINE POSITION data-item, where data item has the JUST clause, now works as expected
when the ADISCF pre-clear option is selected.
3126794 (1111471)

+ BLANK SCREEN BACKGROUND-COLOR n, where n > 7, now sets the intensity so that the bright
version of the color is used to fill the screen.

2856949 (1103978)

Application Workflow Manager
Back to the list

AWM now supports processing output parameters returned by z/OS jobs submitted by ISPF tools.

3176750 (1115818)
« Anissue with resource out-of-sync exceptions while loading AWM systems has been resolved.

3174553 (1115645)

« Added additional trace options for debugging problems related to AWM function packages. See
"Gathering information for Micro Focus SupportLine" in the product Help for more information.

3169085 (1115199)

* The "Compile" context menu command was not visible when multiple programs were selected in the
"Application Explorer" view.

3161802 (1114563)

* Viewing VSAM files from the MVS Explorer with the Micro Focus Data File Tools editor caused an
exception and locked the mainframe file. This is now fixed. Opening a non-VSAM file with any external
editor now produces a descriptive exception.

3149730 (1113716)
« When Link with Editor is active in the Remote Systems view, the corresponding remote element is
selected in MVS Explore and JES Explorer depending on the active editor.

3142129 (1112852)

* You can now edit or browse data sets or members referenced by DD DSN statements from the JCL
editor.

3140150 (1112968)

» The effective record length of z/OS files opened through MVS Explorer is now displayed as a dark red
dotted margin in Micro Focus editors.

3139675 (1112970)

« Password property values are now masked in AWM views and basic trace messages. They do not offer
encrypted password security.

« The default value for a property is now also respected for mass processing input parameters of tool
descriptors.

« Jobs are now sorted by their local submit time in the Jobs view with the most recent positioned at the
top of the list.

e The z/Server Search function did not work properly on data set names with special characters - for
example "§" with code page IBM01141.

3182423 (1116249)

» Using the AWM Eclipse Base Model template caused exceptions on loading cached elements, for
example, after restarting Eclipse. This has been fixed.
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AppMaster Builder

Back to the list

* Anissue with the APRPROG member erroneously containing program source code has been fixed.
3155031 (1113985)

* The Copy+Add feature executed on an APSSCRN object sometimes failed to copy the contents of the
screen. This has been fixed.

3160879 (1114467)

« Application loading performance has been improved, and the tree view has been updated to show a
question mark (?) next to items that are not in the local project, i.e. items that might be found in a
workgroup or in a mainframe dataset.

3162920 (1114651)
* Renumber/Unnumber support is now available in the Editor for APSDATA elements.

3157450 (1114229)

< Anissue that caused pasted text and the text before the cursor position to be pasted incorrectly has
been fixed such that it is now split into multiple lines.

3153690 (1113860)

» Highlighting text and pressing TAB could produce inconsistent results. The selected text will now be
shifted to the right and remain selected.

3139760 (1112620)

* You could receive an exception that was when expanding Treeview or when Editing on accessing Online
Express in AMB in the Team Developer perspective.

Assembler Support
Back to the list

« Two Assembler copyfiles mistakenly received the short form of COBOL copyright statements which
resulted in the programs of the Assembler ACCT tutorial assembling with errors.

Character Animator
Back to the list
< Animator no longer slows down when continuously pressing Step.

3175862 (1115750)

* Animator can now successfully locate executables via the COBPATH environment variable when the
COBPATH value is longer than 1024 characters.

3160496 (1114416)

« Breakpoints are saved (that is, an .aif file is created) when CBL_DEBUG_START is used and the
process terminates.

3143776 (1113225)

Cob/Cbllink/Cblnames (32-bit PC)

Back to the list

e Creating an executable or shared object with the cob flags -U or -d no longer results in an assembler
error message.

Codeset Support
Back to the list
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» JCL jobs executed via the cassub command no longer produce RTS 114 MFTRNSDT errors.

3173144 (1115497)
» Conversions from ASCII to EBCDIC, with null data, no longer get corrupted.

3155499 (1114114)

Communications Server
Back to the list

* In some versions of Enterprise Server, a TN3270 conversation would hang if the ATTN key was used.
This has been corrected.

3173146 (1115498)
« The transferring of files via CICS RECEIVE is now working as expected.

3159602 (1114325)

« Enterprise Server has a service deployment feature, which allows developers and administrators to
install new COBOL services (web services and EJBs) into an Enterprise Server instance over the
network. This functionality has been enhanced for additional security, with various options for user
authentication and authorization. See the product documentation for details.

Compiler
Back to the list

* A GO TO statement that references a qualified data name, rather than a procedure name, is now
correctly rejected by the Compiler.

3191922 (1117013)

« A DBCS data item with a VALUE clause specifying ALL NX literal is now correctly rejected by the
Compiler.

3191623 (1116974)
« Large UNSTRING statements no longer produce the following error: "001-f internal error 49".

3189648 (1116838)
e A SET 88-level TO TRUE statement when the associated field is national is now working as expected.

3185855 (1116554)
« Avalid data declaration with a RENAMES THRU clause referencing other level 66 items no longer
produces Compiler error "COBCHO0239S First data name does not precede second".

3184128 (1116376)
« Parsing programs that contain numerous errors no longer causes Eclipse to crash.

3183896 (1116502)

« A WHEN OTHER clause directly following another WHEN clause in an EVALUATE statement is now
rejected by the compiler when an Enterprise Cobol dialect is specified. This emulates the mainframe
behavior.

3183810 (1116464)
« An RM dialect now supports data hames up to 128 bytes in size.

3182342 (1116261)
» Specifying an inline method invoke inappropriately (such as in a SUBTRACT statement) now receives a
Compiler error, as expected. Passing inappropriate operands BY REFERENCE is similarly rejected.

3180642 (1116128)

< A program compiled with the prexml preprocessor and the directive 'NOQUAL' now compiles as
expected.

3179843 (1116304)
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A REPLACE statement that caused the last token of a copyfile to be replaced with a longer token, and
thus caused the creation of an extra line, now works as expected.

3178437 (1115957)

A COBOL program compiled with a mainframe dialect should treat mainframe KSDS files correctly.
They are of variable length regardless of whether the "record varying" phrase is used in the FD.
Previously, this was not being honored and when program A was calling program B using external files,
you received an RTS 226 error message.

3176783 (1115839)
User-defined functions with LOCAL-STORAGE data now compile and execute as expected.

3176478 (1115792)

A DISPLAY statement as the last line of an ON EXCEPTION clause of another statement, with a
following NOT ON EXCEPTION clause for the containing statement, and compiled with the RM compiler
option, now compiles as expected without internal errors.

3175442 (1115876)
An INSPECT CONVERTING statement with hexadecimal literals and compiled with
CHARSET(EBCDIC) now executes as expected.

3174833 (1115673)
Constructions of type INSPECT CONVERTING ZERO to <variable-name> now produce correct object
code and execute as expected.

3174064 (1115580)
An SQL program with file declarations and a missing WORKING-STORAGE header now executes as
expected.

3169882 (1115216)
During compilation, if the LIST directive had been specified and a license error occurred, an RTS error
114 would result. This has been fixed.

3169377 (1115474)
During compilation, if the LIST directive had been specified and a licensing error occurred, you received
an RTS error 114.

3169377 (1115319)

A COPY REPLACING statement spanning multiple lines, with commas on the end of those lines, is now
processed as expected; that is, those commas are treated as meaningful characters rather than simply
separators.

3168125 (1115173)
PARAGRAPH and CYCLE are now correctly treated as context sensitive reserved words under an
Enterprise COBOL dialect, allowing them to also be defined as user data names.

3167488 (1115004)
COPY SUFFIXING and COPY PREFIXING syntax now compiles and works as expected for long DBCS
words.

3166159 (1114885)
The IMTK wizard can now process COBOL source that contains non-standard characters, such as an
ampersand.

3164533 (1115157)
Syntax involving an EXEC keyword, within an EXEC SQL statement, is now processed as expected.

3162629 (1115879)
The INSPECT ... CONVERTING ... TO FUNCTION ... syntax is now working as expected.

3160325 (1114393)
Compilation with the CP preprocessor, of a source that has very long lines and unexpanded tab
characters at the end of those lines, now works as expected.
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3160255 (1114436)
A DISPLAY of a group item containing a large table, in a program containing the 'CONSOLE IS CRT'
special-name clause now compiles successfully.

3157068 (1114326)
The performance of the following syntax has been significantly improved, especially where source-
alphabet is long: INSPECT CONVERTING source-alphabet TO target-alphabet

3157067 (1114137)

DISPLAY of a SCREEN SECTION sub-group no longer gives a COBRT153 error if there are other sub-
groups with OCCURS items with un-initialized indexes.

3154391 (1113915)
Printer files under an RM dialect are now emulated correctly.

3143299 (1113494)
DISPLAY UPON ARGUMENT-NUMBER now behaves as expected under CHARSET"EBCDIC".

3116649 (1110478)
When evaluating a method invoked inline as in the example below, the method was executed for each
WHEN statement which could result in undesired side effects. Example:

evaluate object: :"method" (1)
when 0O
when 1
when 2

Now, the result is stored in a temporary item and used in any comparisons with the expressions in the
WHEN clause.

Compiling a very large COBOL program with many GO TO statements to JVM no longer results in a
verification error on program load.

3188208 (1116743)

A CALL statement USING by reference the address of a non-01-level linkage item no longer causes the
containing linkage record to have a new address on return from the call.

3179701 (1116403)

Very large programs including XML PARSE or XML GENERATE statements no longer produce system
errors during compilation to JVM.

3179669 (1116054)

An INSPECT phrase without BEFORE/AFTER, followed by another with either BEFORE or AFTER, no
longer leads to incorrect results.

3172678 (1115458)

With the ODOSLIDE directive on, bad code is no longer sometimes generated for JVM, and you no
longer receive a verification error at program load.

3167786 (1115063)

Very large programs with highly overlapping perform ranges could generate bad class files, causing
verification errors when attempting to load. This has been fixed.

3166644 (1115146)

This release provides a new utility, GetBias. It enables mapping of line numbers output from large
COBOL programs compiled to JVM onto real sequential line numbers. If the length of a COBOL
program exceeds 65536 lines, the compile will adjust the line numbers output to the JVM class file, but
subtracting a 'bias’ value from the actual value. In cases where such a program throws an exception,
and the line number is therefore displayed as part of the stack trace, the GetBias utility enables you to
discover the true sequential line number.

3161708 (1114641)



* When compiling for managed code, if a variable length group is passed as a parameter to another
program, the generated code was attempting to evaluate the current length of that variable length group.
In native code, this evaluation only happens in the case where the OCCURS DEPENDING ON item is
not itself part of the variable length group. This difference meant that in some cases a null pointer
exception could occur in managed code, whereas native code executed without error. Managed code
behavior has now been modified to be compatible with that of native code.

3154134 (1113891)

* When debugging an SQL program, stepping an EXEC SQL OPEN statement could cause the final line
of the program to be incorrectly highlighted.

3191710 (1117009)

* In native generated code, on all platforms except Intel x86 32-bit, a COMPUTE statement with fixed-
point operands and a floating-point (comp-1 or comp-2) target could give the wrong result if a fixed-point
operand was used twice in the expression. This bug has been fixed.

3188676 (1116745)

* On the IBM mainframe, when code is compiled with NOPFD, and when an unsigned COMP-3 item
containing an invalid sign nibble (such as 0xD) is the source item in a MOVE to another COMP-3 item,
the sign nibble is fixed up to the correct value: 0xC for a sighed COMP-3 target, and OxF for an
unsigned COMP-3 target. Micro Focus COBOL now emulates this behavior when code is compiled with
SIGNFIXUP.

3173432 (1115972)

« Anissue where the COBIDY directive was handled inconsistently between the Compiler and NCG has
been fixed.

3163263 (1115112)
e A generate time error where the following message was produced has been fixed: FATAL ERROR
in ../coil/cio_jopt.c:deleting bc() line 41; expected compare .

3160837 (1114435)

« [For 32-bit generated code on Intel x86 platforms only: A bug has been fixed where a DISPLAY
statement in generated code, compiled with LINKCHECK, would not give an RTS 203 error when using
an unassigned linkage item.

3159106 (1114292)

« In generated code, a move of the form "MOVE NATIONAL-ITEM TO NATIONAL-ITEM-JUSTIFIED"
produced incorrect results when the target item was longer than the source.

* CHAIN <literal> ON EXCEPTION and CHAIN <literal> ON OVERFLOW did not work correctly when the
overflow case occurred in native generated code on all platforms, with the exception of Intel x86 32-bit.
This has been fixed.

Enterprise Server
Back to the list

« There is no longer an issue with the order of file retrieval for the list of console logs affecting the
calculated maximum log number.

3192214 (1117023)

* LRECL fields are now displayed correctly in Data File Tools when accessing Enterprise Server hosted
data files.

3186524 (1116586)
e Anissue with stopping printer terminals has now been resolved.

3185553 (1116498)
e MQ Security is now used when using DSNRLI.

3183523 (1116641)
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A BATCH DLI job executed in a region with at least one XA switch active could abend at the end of a
JOB on a SYNCPOINT PREPARE failure.

3181636 (1116221)
« In Data Files Tools, the performance of opening a PO dataset that is hosted within Enterprise Server
has been improved.

3178780 (1116293)
e Anissue that caused CTG requests using SNT users to be rejected has now been resolved.

3178729 (1115967)

* Anissue with IBM PCOM was resulting in different colors in BMS in RUMBA and PCOMM. To work
around this, use the new environment variable ES_3270_REMOVE_NULL_COLOR_ATTRIB. Set
ES 3270 _REMOVE_NULL_COLOR_ATTRIB toy or Y to prevent the color attribute set to null from
being sent in a 3270 flow.

3176924 (1115831)
e The MQ XA switch modules now supports the BATCHONLY option.

3173781 (1115552)
« Previously, xwbauth user exit was not invoked if URIMAP path was greater than 64 characters.

3173349 (1115514)

« When a region was configured to use Extended User Storage, the associated memory was not
registered with MFPM. This resulted in issues when using GETMAIN SHARED from a program
compiled with the AMODE directive.

3173307 (1115549)
e CICS no longer attempts to map responses for DELETE requests for JSON RESTful services.
Previously, this was causing the service to hang or encounter a Run-Time System error in dfheserv.

3172688 (1115459)
« casout will no longer crash when using the /v option and there are more than 256 initiators/batch
printers/mprs.

Information for approximately 1300 processes can now be returned. If more than that exist, then casout
will return as much as it can and set return-code to 4.

This may be caused by schedulers using the entry point ‘casout_getSEPS'. This can be called after
using the casout API with the /v option. The signature for this entry point is:

entry 'casout_getSEPS' using Ik-casout-area.

Ik-casout-area is defined in casbout.cpy but can only hold information for up to 256 processes. If there
are more than 256 processes then a call to this entry point will return truncated data (that is, 256
instances) and set return-code to 4.

Since casout /v can now return data for more than 256 processes, a new optional parameter, which is a
pointer, has been added to casout_getSEPS:

entry 'casout_getSEPS' using Ik-casout-area Ik-casout-user-area-ptr.

If there is data for more than 256 processes, then this pointer will be set to the address of the entire
block of data.

3171604 (1115376)

« An EXEC CICS RELEASE statement now cancels the LOADED program as expected. Also, the
behavior of the statement is aligned with IBM's documentation and programs that are LOADed without
HOLD are cancelled/released at the end of a task.

3171175 (1115378)
< Transaction routing requests from the same terminal to an ISC connected region involving a DPL
request to an APPC connected SYSTEM now execute successfully.

3170073 (1115270)
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Transactions with a timeout that was running over midnight were timing out prematurely at midnight.

3169194 (1115144)

CICS files configured to use a catalog entry were subject to a "fix-up" process which resolved alternate
indexed dependencies when certain events occurred - for example, SET FILE ENABLE. This has been
changed and the fix-up is not systematically driven. Changes applied to the associated catalog entry
are no longer picked up automatically. If such changes are made, a fix-up can be requested through the
Active FCT view. The file must be closed before the request is made.

3168298 (1115080)
Event manager exits that are enabled for SEP termination events are now invoked when a SEP, Initiator,
MPR or a printer is stopped cleanly (from ESMAC and casout) and not just when they are killed.

3168159 (1115051)
The cursor position is now correctly identified when using floating maps - a map on top of another map.

3166543 (1114958)

When starting a CICS Web service application, the start code on ASSIGN was 'S ' instead of 'U ". Also,
a residual EIBCALEN value was left when the application was using channel and containers instead of
commarea. These issues have been fixed.

3166323 (1114912)
If created from a previous run, cas_ipcs.Ist and cas_ps.Ist will now be deleted at the next region startup.

3165807 (1114872)

In a heavily loaded Enterprise Server cluster, it was possible for jobs to be dispatched to a printer
process instead of to a batch initiator. This would result in the job's lock being permanently held and
prevent further submission of jobs of that name.

3162806 (1116082)

When Enterprise Server activates an LU62 connection to the mainframe or to another APPC linked
system, you can now leave the modename to SPACE. This indicates that the remote side of the APPC
connection should use an elected default modename.

3162296 (1114713)

When the last CICS API of a program invoked by an ECI client fails and this program handles the
exception, if this program terminates with a GOBACK rather that an EXEC CICS RETURN, the ECI
client does not receive an error anymore.

3161830 (1114584)

The position of a cursor on a map which size is different from that of the terminal size was incorrect.
This has been fixed.

3158745 (1114273)
In an ESM secure region, when the userid field in a terminal definition was populated, there were issues
at region startup or when trying to install the TERMINAL resource.

3158468 (1115137)

The environment variable ES_DDBG_PORT_RANGE now supports ports that include less than five
characters.

3158205 (1114237)
With ES_XA_NB_RETRIES=-1 specified, Enterprise Server would leak SHM if the connection to the XA
RM was lost.

3158011 (1114246)
CICS Web service response messages larger than 64Kb are now returned correctly.

3155900 (1114044)

Previously, the transformation of data from COBOL to JSON in CICS Web Services would not collapse
whitespace even when CHAR-WHITESPACE=COLLAPSE was used for the generation of the wsbind
file.
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3154716 (1113953)
« Anissue where a region would take too long to start up and eventually fail to start has been resolved.

3153774 (1113875)
« Return codes from file operations on the spool files are now displayed correctly when there is an error.

3153516 (1113882)

« When Data File Editor accesses files managed by an enterprise server region, users now need
UPDATE permissions in order to access the file exclusively.

3152798 (1113831)

* You can now configure certain fields within the record that is written to a .csv format HSF report. Use
the ES_HSF_CFG environment variable to configure the number of Custom, CICS file, TSQ, and TDQ
fields in each record. To write custom data to the Custom fields, use the ES_ WRITE_CUSTOM_HSF
library routine. See the latest SupportLine help for more information on these new features.

3151200 (1113676)

*  When connecting a TN3270 to an Enterprise Server instance, if the connection was lost, the printer
could not be reconnected. Now you can navigate back to ESMAC, then Clients, and stop the printer in
order to reconnect it after a loss of the connection.

3142113 (1112847)

< Formatting a trace that was captured during the period when the clocks went back an hour will now
format the entire trace. Previously, the formatter would exit at the point when the clocks changed.

2876312 (1106883)
« Anissue with exporting PCT resources has been resolved.

« Enterprise Server, LDAP-based security: The use of Active Directory groups, or other group classes
that specify membership using LDAP Distinguished Names, now works correctly when the "user ID
attribute” configuration option is also used.

3187284 (1116696)
* The Enterprise Server External Security Facility (ESF) now strips leading and trailing whitespace from
the user ID and other relevant fields in Verify (user authentication) requests.

3185569 (1116548)

« For Enterprise Server LDAP-based security, recent fixes to group processing exposed an issue when
multiple LDAP repositories are used and all-groups mode is enabled. This could cause some or all of a
user's group memberships to be disregarded, leading to incorrect denial of access to resources. The
problem has been corrected.

3182724 (1116269)

« Enterprise Server's MLDAP ESM Module now supports setting LDAP passwords using salted
SHA2-512 hashes. Otherwise known as the SSHA512 LDAP password type.

3178540 (1116077)

* In Enterprise Server with LDAP-based security where a security configuration uses two or more LDAP-
based Security Managers, and use-all-groups mode and group federation are enabled, in some cases
group membership was not processed correctly. Messages about "configured number of groups
exceeded" could be logged. This issue has been resolved.

3178071 (1115917)
» With certain Enterprise Server security configurations, the Data File Editor could display a "signon
failed" error when attempting to edit a dataset. This has now been fixed.

3177366 (1116022)

« The cache feature of the Enterprise Server External Security Facility now ignores some metadata when
comparing requests with cache entries. This is configurable. By default, the subsystem (CICS, JES,
etc.) and facility (terminal name, if any) are ignored. No ESM Modules supplied with the product use
that information in making security decisions. This significantly improves the cache hit rate and system
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performance in some environments. See "Enabling and Configuring Caching" in the product
documentation for more information.

3172719 (1115513)

When using LDAP-based security for Enterprise Server with an OpenLDAP-based provider (client)
library, the "connect timeout" setting now works correctly.

3172554 (1115522)

When using Enterprise Server with LDAP-based security, it is now possible to specify an LDAP attribute
for user-group objects which specifies an alternative name for the group using the group short name
attribute. See "MLDAP ESM Module Custom Configuration Information™ in your product Help for more
information.

3171437 (1115364)

Enterprise Server LDAP-based external security no longer experiences a rare failure ("error code 7")
when verifying a user with advanced group processing options enabled.

3168197 (1115048)

LDAP-based security for Enterprise Server could produce MD5 password hashes (using the
"mode=bind" and "password type=MD5" configuration option; note this is rarely used) which did not use
the canonical Base64 encoding. Some LDAP servers did not recognize these password verifiers,
resulting in sign-on failures after users changed their passwords. This has been fixed.

3162441 (1114843)

In Enterprise Server, the MLDAP ESM Module now supports the short-to-long username mapping
option of the External Security Facility (ESF).

3160464 (1114394)

Enterprise Server now includes LDIF (LDAP Data Interchange Format) files suitable for configuring
LDAP-based security using the OpenLDAP server.

3147666 (1113475)

Enterprise Server's optional LDAP-based security (External Security Facility with MLDAP ESM Module)
now supports the Microsoft "group” LDAP class, as used by Active Directory and AD/LDS. Consult the
online product Help or ask Micro Focus Customer Care for additional information.

3109881 (1110084)

On Linux and UNIX platforms, the MLDAP ESM module in Enterprise Server LDAP-based security, by
default searches for an appropriate LDAP provider (client shared object) in the default locations used by
the OS vendor's preferred LDAP client package. It is also no longer necessary to specify the "provider"
option in a Security Manager configuration.

After changes to RPI 632930, a literal with spaces at the end caused a compilation error when used in
SEND MAP. This is now fixed.

3187511 (1116671)

An issue that caused BMS Paging to terminate when no PFKeys were defined in the SIT has been
fixed.

3184331 (1116708)

CICS Web Services requester applications were not always sending the correct value for the
SOAPAction header.

3182512 (1116255)

An issue with the CASA_ECI function was causing a run-time error on calls to modules loaded via CICS
LOAD HOLD. This has been fixed.

3177527 (1116614)

INQUIRE TASK, SET TASK FORCEPURGE and SET TASK KILL now work when passed a task ID that
corresponds to a task running in a transient SEP.

3176467 (1115802)
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« EXEC CICS ASSIGN PRINSYSID now returns the system identifier (SYSID) of the principal facility on a
DTP exchange.

3176355 (1115959)

e EIBTASKN now conforms to IBM CICS with a maximum value of 99999. When reached, the task
number rolls over to a value greater than zero.

3168772 (1115148)
< Anissue that sometimes caused an infinite loop in user prologue code when multiple CALLs were made
to the same CICS compiled program has been corrected.

3168646 (1115243)

« UTF-8 special characters used in languages such as Swedish and German are now supported for
dataset names and in FCT resources.

3168514 (1115156)
* Anissue that caused a long-running task that issued an EXEC CICS SYNCPOINT to throw a duplicate
XID error has been fixed.

3167061 (1115223)

* Programs containing CICS RECEIVE INTO / RECEIVE MAP in a DBCS environment and compiled to
ASCII produced an erroneous @ symbol when data sent as part of a MAP was truncated using the
Delete key. This has been fixed.

3166924 (1114956)

* Anissue in identifying the first available open port for regions containing multiple TCPIPService
definitions that use the same port has been resolved. Enterprise Server now searches all ports that
match the port number provided by the request, and uses the first available open port. If an error
occurs, a message is returned to the client.

3165836 (1114892)
e Anissue with creating FCT entries with 'Use Catalog' has now been fixed.

3165308 (1115000)
* The following options have been implemented for SET TERMINAL:

PURGETYPE(PURGE) / PURGE
PURGETYPE(FORCEPURGE) / FORCEPURGE
PURGETYPE(KILL) 7/ KILL

TERMSTATUS(RELEASED) / RELEASED

3164392 (1114739)
* Messages containing %s caused a CASCD error. This has been fixed.

3164390 (1114738)

* Programs that contained RECEIVE INTO followed by a RECEIVE MAP using FROM and INTO options
caused errors when compiled to ASCII. This has been fixed.

3164053 (1114708)

« The attention key was lost when using CSPG, this has now been fixed. When defining the BMS
PAGING KEYS, you need to use the command first before the value for the key. For example, if the
retrieve command is P/ then the PFK1 should be set to P/N (N for Next), PFK2 P/P (P for Previous) and
so on.

3161110 (1114505)
e casrdtup now supports all valid characters in the TDQ Name.

3161013 (1114461)

« XWBAUTH is now invoked on CICS INVOKE SERVICE when the associated URIMAP is defined with
AUTHENTICATE(BASIC). Important: With this update, all applications that use WEB CONVERSE or
WEB SEND SESSTOKEN explicitly with the AUTHENTICATE, BASICAUTH, or NONE options, and that
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do not use a URIMAP that specifies the AUTHENTICATE attribute, must be recompiled. (This does not
affect applications that use a URIMAP that specifies the AUTHENTICATE attribute.)

3160060 (1114599)

Support for the client WEB SEND command has been updated to include support for the BASICAUTH
option.

3160060 (1114388)

A copybook required to build the printer exit was missing. This has now been fixed.

3159328 (1114322)

The INQUIRE TSQUEUE and TSQNAME now read direct for "non-browse" INQUIRE requests. Support
for numitems has also been enabled.

3156161 (1114077)

To fix An issue with the maximum length for a query string being too small, it has been increased from
255 to 1024.

3155607 (1114025)

The DEFINE TRANSACTION topic has been updated to correct the descriptions for the DTimout and
Runaway recovery keywords.

3132186 (1111913)

An issue which resulted in the DELETE and DETAILS button staying disabled in the casrdo45 page has
now been fixed.

3181230 (1116351)

Previously, when viewing cataloged datasets or Spool files in ESMAC, it was not possible to view any
lines beyond line 99,999. Now the limit for the START field in ESMAC has been increased to hold any
number up to 99,999,999.

3181032 (1116152)

An RTS error 153 occurred when more than 6400 PCT entries were displayed in ESMAC. This has
been fixed.

3167388 (1115007)

With some specific LDAP configurations there were problems with accessing datasets from ESMAC
where the configuration should have allowed access. This has now been fixed.

3167364 (1114989)

The response time for catalog searches using 44 character strings in ESMAC has been improved.

3162969 (1114933)
Remove locks is now enabled if the user has authorization in ESMAC.

3157534 (1114372)

Deprecation of set-cookie meta tag in newer versions of some browsers such as Chrome or Microsoft
Edge caused issues with the cookies used by ESMAC. This has now been resolved.

3154175 (1113973)

The new JCL-specific environment variable ES_JES_SORT_SPOOL_BY specifies which column is

initially used to sort the spool records in casrdo41: ES_JES_SORT_SPOOL_BY=JOBNAME|SUBDATE|
JOBUSER

Note: If any other value is specified, then the spool records are sorted based on the JOBNUMBER
(JOBID).

3152682 (1113846)

The esfadmin command-line utility now allows command-line and option-file parameters of any length,
up to the maximum command-line length of 8192 bytes. All esfadmin parameters can appear in the
option file except -o (which specifies the name of the option file).
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2881372 (1107519)

When using Enterprise Server with LDAP-based security, with two or more LDAP External Security
Managers, with the use-all-groups mode enabled, and with federation either enabled or in compatibility
mode (the default), it is no longer necessary to have a definition for each user in each LDAP ESM.
Specifically, once one LDAP ESM has identified the user, subsequent ESMs (those specified later in the
list of security managers) can specify additional groups for that user without having to define the user
again. For example, a security configuration specifies two LDAP security managers, LDAP-A and LDAP-
B. LDAP-A contains only user records. LDAP-B contains only group records and resource access rule
records. All-groups mode and federation are enabled. This configuration now works as expected.

2545079 (1081762)
xa_open in the switch module now returns the correct return-code.

3171133 (1115386)

The path of ESDB2XA switch module is not required in the environment variable LD_LIBRARY_PATH
when the application is compiled with XAID option and the dynamic switch module is used.

3164301 (1114734)

Within the DB2 LUW switch module, issues associated with ESLOGGING xa_open string parameter
have been addressed, and better handling of impersonated userid when using USERP has been
provided.

3156639 (1114209)

Data Tools

Back to the list

The cursor is now visible in the free-text editing pane when the pane has focus whether it is in Shared
or Exclusive mode. The cursor position will start counting from column 1, rather than column 0 as well.

3154869 (1113954)

On systems with a Japanese Locale, the Data File Tools utility no longer includes the phrase "Technical
Preview" in its title.

The IMS DB Editor's handling of segment layouts that contain hyphens has been improved.
3156235 (1114112)

You can now merge your archived spool files to a central location, using a JCL job or by using a
command line utility. Once merged, they can easily be viewed together using the Micro Focus Data File
Editor.

3154771 (1113949)

Debugging
Back to the list
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The COBOL debugger could fail to determine the correct line to highlight in certain situations such as
'stop run’, when run in the Docker environment on Windows.

During animation on SUSE Linux Enterprise Server (SLES) 12, if the process being debugged was
waiting in a system-call and you attempted to exit the debug session, the session would have been
terminated rather that executing a 'stop run' in the debugger. This was due to a change in the operating
system between versions 11 and 12, which has now been corrected so that a 'stop run' is now correctly
executed.

While using the Character Animator to animate a program, if its stack overflows, the debug session no
longer stops - it now returns you to your source code and displays an error message.

Whilst debugging, examining variable values by hovering over the variable no longer causes an error.
3179385 (1116025)



Dialog System

Back to the list

An issue which prevented character mode Dialog System from recognizing ctrl-J and other key
combinations has been resolved.

3189921 (1116908)

Documentation

Back to the list

The documentation for the compiler option -rc has been updated.

3184345 (1116419)
Result precision has been added to the following built-in functions topics in the LRM: INDEX,
MAXLENGTH, SEARCH, SEARCHR, VERIFY, VERIFYR.

3183332 (1116336)

The product help now includes a clarification in the topic "To run a native COBOL application from a
network server”. It states that you must remove any individual copies of run-time system modules (for
example, cblrtsm.dll) that might have been copied into your application’s working directory. This is to
avoid issues with running the application such as "245 no valid licenses found" as the run-time system
is not loading from the expected location, or where the copied run-time modules are from other versions
of the product versions. Removing such modules ensures that any run-time system modules are only
loaded from the Enterprise Server instance installed on the server.

3176098 (1116309)

The Software Requirement on UNIX topic in the docs and in the Release Notes now specifies that
SafeNet licensing requires that you have glibc-locale-32bit library installed on 64-bit machines.
3167672 (1115010)

The UNIX syntax example for the MAKESYN Compiler directive has been corrected in the
documentation.

3164533 (1115496)

Depending on the environment, you need to export (UNIX) or set (Windows) environment variables in a
script. See “To specify environment variables for an application” for more information.

3164533 (1116625)

The documentation now includes the instruction that when deploying a subset of Run-time System files,
you must include run.cfg in a sub-directory named 'etc'.

3160902 (1114441)

The syntax example, listed in the documentation for the ILPARAMS Compiler directive, has been
corrected.

3154632 (634308)

When performing a sort that specifies more than one input file, you cannot specify one of those same
files as the output file unless it is the first input file specified.

3153333 (1113833)

Details of how to use ILBOABNO have been added to the documentation.

3148996 (1113634)

The documentation (in the COBOL Language Reference) has been updated to clarify the use of the
OPTIONAL keyword, and the use of (managed) optional parameters within the Procedure Division
Header.

2883545 (1107792)

The National Locale Support (NLS) Library Routines section of the documentation now contains all
available NLS routines.

Resolved Issues
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« The Significant Changes in Behavior section of the documentation now includes the default change for
FASTINIT. (This change occurred in version 3.0, as stated in the release notes on release.)

« The documentation has been improved for the CBL_LOCATE_FILE library routine concerning the use of
space- and null-terminated strings.

« The Rebuild syntax differs between UNIX and Windows platforms. For any of the Rebuild options, UNIX
platforms use a hyphen (-) prefix before the letter, and Windows platforms use a forward-slash (/) before
the letter.

e The recommended method of high availability for VSAM files in Enterprise Server is to use standalone
Fileshare. The documentation has been changed to reflect this.

« The documentation has been updated to reflect that 'DEFAULT" is a reserved word when running under
an ENTCOBOL dialect.

* In the documentation, the code example given in the 'Thread-specific Data Handling Routines' topic
now compiles cleanly.

* The called program search order, as documented in the '‘Backward Compatibility' section of the
documentation, has been corrected for Windows platforms.

e The parameter definition for OOCTRL"+/-W" has been clarified in the documentation.

* The documentation now contains a topic - Using a File Handler in JVM COBOL - detailing how to
manually configure the File Handler that a JVM COBOL project uses.

« Alink to the IBM documentation added to the 'DSNRLI Functions used for RRSAF' topic - this is to
enable you to locate full details on required parameters, and to give examples of its use.

3184952 (1116524)

« The documentation now states that the section heading when adding environment variables through the
Enterprise Server Ul is case sensitive.

3177135 (1115979)

e The CICS Support section of the documentation, under Mainframe Programming, now contains a
sample XWBAUTH program that can be adapted when users create their own user exits.

3164415 (1114826)
« The documentation explaining the scope for the HOST-NUMCOMPARE directive has been simplified.

3156368 (1114075)
« The "To specify the location of application files" topic has been updated to clarify the location of IMS
copybooks.

3111136 (1109993)

« Documentation for all Java API classes is now provided in HTML format and contained in an archive file
located by default in the %ProgramFiles(x86)%\Micro Focus\<product name>\javaee-ccl\docs directory.
See the Java API Classes topic in your product documentation for details.

3109273 (1109725)

< Documentation for all Java API classes is now provided in HTML format and contained in an archive file
located by default in the %ProgramFiles(x86)%\Micro Focus\<product name>\javaee-ccl\docs directory.
See the Java API Classes topic in your product documentation for details.

3109271 (1109724)

« The documentation on setting up an SMS data class has been improved, which now includes a working
JCL sample.

* The sample code listed in the CBL_DIR_SCAN_READ documentation has been formatted to enable
you to copy and paste the code, ready for compilation.

* The sample in the documentation on 'Using FHRedir and an allocation override rule' has been corrected
to show the spool filenames in their correct case (upper case).

« The documentation now includes a definition for the system abend code S913 (which is "Security
Violation - the user is not permitted to access the resource").
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Embedded HTML Pre-Processor
Back to the list

An issue that caused the embedded HTML preprocessor to display incorrect banner information has
been corrected.

3160255 (1114437)

File Handling

Back to the list

Under certain circumstances, opening a sequential file in the editor could result in the editor throwing an
exception during close-down. This has now been resolved.

3145420 (1113132)

Warning messages when checking disk space for Fileshare advanced logging are now only displayed
when necessary. Previously, a disk space warning was given even if sufficient space was available.

3174510 (1116078)
A Fileshare server shutdown no longer leaves files opened or users remaining logged on.

2837526 (1108076)
CFLE updating large record no longer results in an RTS252 error with the HA-VSAM configuration.

3167973 (1115057)
You will no longer receive an RTS114 error when a failing primary node is restarted and attempts to re-
join the HA group (as a standby node), as long as it closed all files successfully before the failure.

3159872 (1114360)

Rollback recovery will no longer hang when processing a bad log entry during a scan of the transaction
log file.

3168055 (1115049)

A new MFJSORT option allows input LSEQ files to be treated as FB through setting the environment
variable MFIJSLSEQFB=ON.

3190089 (1116876)
SORT operations no longer compare field data that is outside of the current record length.

3187044 (1116633)
MFJSORT now ignores the RECORD TYPE value if the SORTIN dataset is non-VSAM.

3163293 (1114669)
During a SORT, the SUM statement now correctly handles 8-bytes Bl fields.

3161349 (1114540)

An internal SORT program no longer returns a COBRT?252 error for cataloged files when being
compiled with AMODE"31" and dialect"entcobol".

3161100 (1114586)
SORT no longer produces an RTS114 error when both outfil and sortout datasets are not defined.

3154290 (1113901)
MFJSORT now correctly honors MFJ_INPUTDS_ERROR=N on missing physical concatenated
datasets.

3153313 (1113826)
MFJSORT OUTREC now applies the correct length for EDIT patterns.

3145526 (1113484)
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IBM Language Environment for OS/390 & VM Support
Back to the list

Calling CEEGTST routine in LE support under JVM COBOL could sometimes result in an RT198 error.
This is now resolved.

3193016 (1117082)
An issue resulting in an RTS 173 error when using LE370.jar and 'Dynamic calls' has been resolved.

IDE
Back to the list
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Multi-dimensional arrays are now displayed correctly in the Expressions view.

3188114 (1116718)

We have resolved an issue where sources using $set P(cobsql) _and_ a directives file were not
correctly background parsed

3187247 (1116715)

An issue with parsing comments between parameters in JCL statements and an issue where text
matching JCL keywords caused parsing of DD parameters to fail have been fixed.

3186771 (1116601)
The Show Console Log menu item in Server Explorer now works correctly for servers that have a
‘Configuration information’ property larger than 1024 characters.

3186091 (1116545)

References to .dir files that are located on a separate drive from that containing the project now
resolves the correct drive.

3185960 (1116529)

You can now configure the Eclipse Content Assist to list proposal is alphabetical order. You can do this
from Window > Preferences > Micro Focus > Editor > Content Assist, and from the Proposal order
section.

3185289 (1116494)

Data items which contain XML or HTML data during debugging now display correctly in hover popups.

3182322 (1116238)

Text search errors caused by Eclipse's File Search functionality being multi-threaded and being
designed for local projects only have been fixed. File Search might now sometimes be slower but this is
unavoidable due to limitations in how third-party code can be modified.

3182272 (1116231)

Error messages were sometimes displayed on the wrong line when background parsing using the AWM
Remote Preprocessor. This has now been fixed.

3181225 (1116179)
You could experience an issue with starting Eclipse where Java Tooling would fail to initialize. This was
a result of a known issue with INA and installing certain Windows updates.

3179471 (1116030)

SQL Include files were not always resolved when background parsing using the AWM Remote
Preprocessor. This has now been fixed.

3178446 (1115943)

COBOL Copybook project references in .cobolBuild files could be lost after importing the project in
Eclipse.

3177566 (1115903)



Users who have configured ESF passtoken generation can now access certain pages from the Server
Explorer view in Eclipse without having to reauthenticate. These include the spool and catalog pages of
regions, and the administration pages of directory servers.

3177270 (1115887)
It is now possible to compile individual programs within a COBOL JVM project, provided that the "Use
Dynamic Call" option is set within the project's properties.

3176560 (1115882)
Information about variables is now displayed correctly when debugging JVM COBOL using a Remote
Java Application debug configuration.

3173978 (1115582)

we now support ${ipaddress} and ${hostname} in the display preference, the latter is now used in the
default value

3170934 (1115477)

The environmental variables IDE_IMSCONFIG and IDE_IMSDATA no longer include a trailing
semicolon in the enterprise server regions created in Eclipse.

3169831 (1115303)

Smart Edit functionality has been updated to linewrap text, with new line characters pasted into the
editor correctly.

3168633 (1115534)

The PL/I preprocessor attempted to load versions of libxml2.dll which were not part of the Enterprise
Developer product, when invoked from Eclipse. This has been fixed.

3168065 (1115329)

Visual COBOL for Eclipse now starts correctly, with no errors.

3165560 (1114888)

When debugging a remote application via a DevHub server it is now possible to use Remote File
System Directory entries in the Source Lookup search path. Previously, they were ignored unless a
remote project was selected in the launch configuration.

3165087 (1114802)

When debugging a remote application using source code held in local COBOL projects, program
sources were not found if the folders containing them were not included in the project's Copybook
search path. This is now fixed.

3165086 (1114804)
It is now possible to cancel the launch of a "COBOL Wait for Application Attachment" (that uses a
specified host and port).

3164766 (1114784)

The Terminate and Remove menu item is now correctly handled for wait for attachment debug sessions
that have not yet attached.

3164766 (1115747)
A message to clarify the behavior of the environment script location field was added.

3164533 (1116627)
It is now possible to specify the default cobdebugremote port in Eclipse preferences. See "Preparing
Remote Projects for Debugging" in your product Help for more information.

3164533 (1114754)
The X Server font can now be set on the Debug preference page.

3164533 (1115214)

The "Server port, replaces ${port} in command" remote connection attribute has been added to enable
the configuration of the DevHub server port value when launching the server using the SSH daemon.
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See "To launch a server on the remote host using a Secure Shell daemon process" in your product Help
for more information.

3164533 (1114753)

* The COBOL Explorer filter facility is no longer disabled when the view is configured to exclude COBOL
Elements such as the COBOL Programs category.

3164096 (1114782)
» Compilation of assembler files now respects the file specific settings when compiling individual files.

3162115 (1114600)

« You can now right-click on a data item name anywhere in the working-storage or procedure division,
and click "Toggle Watchpoint". This adds a watchpoint to the breakpoints view in the same way as
selecting it from program outline. For CICS EXEC Interface Block (EIB) items, this means you can right-
click on the usage of a data item in the source, toggle the watchpoint and it will be added to the list of
watchpoints.

3161772 (1114579)

* There is now a Compile option in the context menu for folders in the COBOL Explorer and the PL/I
Explorer views.

3161499 (1114526)

e Opening a project properties page in AWM without a project selected in the Application Explorer view
no longer throws a NullPointerException.
3160690 (1114434)

< The "Inherit values from the build environment of the associated project" option in the project properties
(Micro Focus > Run-time Configuration > Environment Variables) was not being honoured. This has
been fixed.

3159999 (1114419)
« Paths to dependent projects are now stored using relative paths if they can be determined.

3159506 (1114321)

* The PL/I include dependency view did not always show the correct files if the macro pre-processor was
enabled.

3158083 (1114846)
» A workspace with several projects that share an output directory no longer rebuilds projects infinitely in
a case when one of the projects compiles unsuccessfully.

3155067 (1113970)
« Double-clicking on file search results now correctly jumps to the line containing the result.

3154115 (1113894)
« Linked resource entries in .cobolBuild are now stored using relative paths.

3153143 (1113836)
* Micro Focus project types now correctly translate copy paths to the new pasted project location.

3152826 (1113856)

« Copying and pasting remote projects has changed its behavior. A new "Copy Micro Focus Project"
dialog box is displayed asking you to confirm the remote details. Note: Micro Focus only support pasting
projects to the same remote connection as the project being copied.

3151350 (1113648)

* When running the Remote Connection Diagnostics function, an unhandled exception was intermittently
logged. This has now been fixed.
3151350 (1114547)

« This release includes initial support for formatting COBOL code. Access the formatting preferences from
Window > Preferences > Micro Focus > Editor > Formatter.
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3146261 (1113549)
END-EXEC and CALL-CONVENTION are now correctly highlighted as keywords in COBOL programs.

3146260 (1113238)
Hit count and conditions are now supported for COBOL watchpoints.

3128708 (1113196)

Invoking the PL/I macro pre-processor multiple times while background parsing is now supported when
the option to background parse using the Open PL/I compiler is enabled in the workspace preferences.

3103429 (1109346)
The COBOL Run-Time System container has been updated to include a reference to mfle370.jar.

Copybooks and include files were not found during background parsing of remote COBOL programs if
they were located in a directory specified by the COBCPY environment variable before the DevHub
daemon was started. This has been fixed.

3165397 (1114851)

IMS Support
Back to the list

The correction to SI 2847064 (RPI 1103584) caused the DBDGEN directive SXRBAFORMAT(2) to
behave as SXRBAFORMAT(0). SXRBAFORMAT(1) was unaffected.

3186315 (1116562)

An issue that caused enforcement of segment delete rules when deleting a virtual logical child (VLC)
segment via an ACCESS=LOGICAL DB view has been fixed.

3183252 (1116497)

An issue that caused a GE error has been fixed. With this fix, the position on a database that supports
POS=M or multiple hierarchical paths is flushed only when the current position on that segment is
different than the previous position, or when the segment being processed is the lowest-level segment
in a GU/GHU/ISRT call.

3167069 (1114975)

The PCB segment level after an unsuccessful GNP call (status GE) did not always match that of IBM
IMS.

3156252 (1114067)

An issue that caused multiple hierarchical database fields to show in incorrect positions on the screen
when the PCB for the database specified POS=M has been fixed.

3155761 (1114070)

An issue that sometimes occurred when a GN or GHN that was either completely or partially
unsuccessful caused the return of an incorrect segment level in the PCB feedback, depending on call
SSAs and prior DB position. This has been fixed.

3153595 (1113843)

IMS BTS tracing was not available for CICS. This is how supported via the ES_SSTM_CICS
environment variable.

3152981 (1113795)

An issue when using a virtual logical child (VLC) with multiple defined sequence fields sometimes
produced incorrect results when using those fields in a segment search argument (SSA) boolean
operation. This has been fixed.

3151898 (1113783)

In some circumstances, a DX status code (DLET rule violation) might have been issued in error or not
issued when it should have been. This has been corrected.

3149186 (1113582)
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* A new IMS-specific environment variable, ES_IMS_OPEN_TIMEOUT, has been added to define the
wait period in seconds during which IMS retries the opening of a database file that is in use by another
task. Default is 30 seconds.

3105263 (1109307)

* The EQU macro is now accepted for PFK values. If the EQU value is a literal spanning more than one
line, then it must be coded such that the value goes all the way into column 71 with a continuation
character in column 72.

3184467 (1116451)
* Anissue with MFS map output caused storage violations in CASTMC. The size of the output buffer has
been increased to correct this problem.

3180502 (1116197)
e Anissue that caused incorrect formatting on print output with multiple DPAGES has been fixed.

3178841 (1116049)

« When compiling the MFS source for EBCDIC, some conditional literal values were erroneously stored in
the generated control block as ASCII, causing a print output error. This has been fixed; however,
previously generate MFS must be regenerated to pick it up.

3178841 (1116848)
* Anissue that caused screen values to be lost when moving NULL to output fields has been fixed,;
however, to restore the screen values, you must regenerate the MFS.

3174377 (1115708)

< Anissue that caused a loss of input data when the PF5 key was pressed repeatedly and rapidly, or
when the keyboard was locked, for an MFS screen set to clear all unprotected screen fields upon
output. This has been fixed.

3157814 (1114455)

* Anissue that prevented dynamic debugging from working correctly when switching to a second IMS
transaction has been fixed.

3180027 (1116094)
*  When XA was enabled, an IMS BMP that issued a STOP RUN instead of a GOBACK caused
unpredictable errors depending on the XA resources defined. This has been corrected.

3165313 (1114838)

e IMS Connect has been updated to support the IRM header to be in either EBCDIC or ASCII. In addition,
system messages returned in the response are now in EBCDIC when the input IRM header is EBCDIC
or the header's IRM_F5 "translation done by client" bit is set (x'40’), indicating the client expects the
response to be EBCDIC. This is consistent with non-system output messages, which are in EBCDIC
when this bit is set.

3179210 (1116368)
« When trying to print during a TN3270 session, the terminal could hang waiting for a response. This no
longer occurs.

3177584 (1116002)
* A program-to-program message-switch to a hon-response-mode transaction sometimes caused a
DFS2082 message to appear erroneously. This has been fixed.

3172148 (1115425)
* A message inserted by a response-mode transaction to an express PCB sometimes causes a DFS2082
message to appear erroneously. This has been fixed.

3168150 (1115053)

e Alimitation with MQ Writer prevented it from automatically reconnecting to MQ after losing the
connection. MQ Writer has been updated to automatically reconnect to MQ if it should lose the
connection.
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3164352 (1114745)
An issue that occasionally caused CASTMC RTS200 (ID: 9¢c12) errors has been fixed.

3159168 (1114303)

To correct An issue with routing MQ-IMS Bridge output messages, these messages can now be routed
to a reply queue based on LTERM, as configured via the new OTMA destination-descriptors
environment variable (ES_IMS_OTMA_DEST).

3154367 (1113959)

IMS support has been updated to include program-to-program message switches from OTMA-
submitted transactions.

3153840 (1113862)

An issue that caused a GN call to fail on a message segment that used an alternative PCB when the
segment was not the first in the message, and its insert was immediately preceded by an insert to a
different PCB, has been fixed.

3153486 (1113857)

Two new Enterprise Server environment variables, ES_IMS_SINGLE and ES_IMS_LTERM_PREFIX,
have been added that enable you to configure support for multiple sign-ons by a single user across
multiple LUs.

3146936 (1113313)

New IMS print exit functionality allows data destined for a printer to be redirected to the DFSPRINT exit
routine prior to any printing.

3140423 (1112727)

Enterprise Developer now increments the task number for "Wait for Input” transactions where the input
message is not the MPP initial schedule message and not a message returned immediately for a
COMMIT/GU request.

An intermittent issue that could result in receiving an incorrect output, RTS 114 error messages and TM
message queue corruptions has been resolved.

Interface Mapping Toolkit

Back to the list

For clients and services generated from WSDL, generated copybooks are no longer missing
declarations for complex WSDL fields with duplicate names.

3188506 (1116761)

A problem that caused invalid xsd:date types in a CICS Web Service WSBIND file generated from a
WSDL file has been fixed. xsd:date types are now generated as collapsed fields.

3184571 (1116456)

A limitation in the Interface Mapper that prevented the simultaneous editing of Field Properties for all
selected fields of a like field type has been fixed.

3164533 (1115571)

An issue that prevented manually created field mappings from correctly matching IMTK behavior has
been fixed.

3164533 (1115657)

JCL Support
Back to the list

mfjctlbp has been enhanced to include the return code, reason code and the return type from a call to
an executable.

3190808 (1116938)
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» Anissue that prevented jobs from being started when an initiator was available has been fixed.

3184852 (1116450)
« The incorrect removal of commas between parameters passed to the REXX interpreter, introduced in
release 4.0 Patch Update 5, has been corrected.

3184475 (1116418)
e Anissue that prevented the MSGCLASS JOB CLASS, and the setting of ES JESYSMSG_OUTPUT
and restrictions, from being honored for SSTM jobs has been fixed.

3183255 (1116438)
e The "Job Completed" date and time for SSTM jobs is now set when the a job is marked as completed.

3183255 (1116764)
* MFFTP APPEND processing has been enhanced to accept the abbreviations AP and APPE, and to
correctly process quoted dataset names.

3182125 (1116215)
* The next generation indexing for a relative generation following a sweep delete of GDG generations has
been improved, to be more consistent with mainframe behavior.

3181663 (1116195)
< Anissue that prevented auditing in 64-bit COBOL processes has been corrected.

3180251 (1116090)
« Performance in retrieving the next JCL job to run has been improved.

3179792 (1116151)
* You no longer experience performance issues with Data File Tools when the editor is displaying PO
entries hosted in Enterprise Server.

3178780 (1116139)

« When opening a data set from the Data File Editor, you can now filter the catalog contents further by
using the 'Disable Additional Qualifiers' check box. This is the same option as is available in ESMAC; it
emulates the effect of disabling the 'Include Additional Qualifiers' option on the mainframe.

3178780 (1115991)
e Within an MFFTP CD command, directories contained within single quotes will no longer have double
quotes added around the single quotes.

3178420 (1115998)
e The incorrect step COND CODE of zero when a PL/l program abends because the OUTLIM value has
been exceeded, has been corrected, and will now be correctly reported as S722.

3177778 (1115902)
< An error was incorrectly being reported when a symbolic parameter substitution split over multiple lines.

3177166 (1115863)

< An error when trying to rename a data set where its location was identified using an environment
variable in the allocation override, coupled with ES_ALLOC_EXPAND=N, has been corrected. The
environment variable is now resolved to the correct physical location.

3176747 (1115832)
« An error when using an in-stream SYSIN dataset in IBEDG, stored in a user catalog, has been
corrected.

3175437 (1115735)
« Alock on a dataset is now removed correctly when using mvscatpb.

3174350 (1115610)
* You no longer received an "Index out of bounds" error message when exporting a catalog using
MFCATXML.

3173762 (1115550)
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If a job abends because it timed out (S322 abend code), any SYSOUT files from the job that were
‘active’ will now be moved to either the OUTPUT or the OUTPUT HOLD queue.

3173743 (1115562)
In MFFTP, the data conversion module name, specified by MBDATACONN or SBDATACONN, is now
parsed correctly and the module called to perform the data translation.

3173596 (1115776)

Program parameters changed by the user exit, MFJUXIT, are now applied correctly. An invalid
parameter passed to IKJEFTOL is reported as such, but does not set a COND CODE of 12. Commands
not found by IKJEFTO01 do not set a COND CODE or stop processing. Commands not found by
IKJEFT1A or IKIJEFT1B are reported, give a COND CODE of 12, and stop further processing.

3173270 (1115511)

Assembler run-time support for SSTM under Enterprise Server is now available. The Assembler run-
time now performs a check for Enterprise Server run-time environments with JCL enabled or with SSTM
enabled for IMS and CICS online environments. If found, Assembler attempts to merge its own MVS
control block emulation with the MVS control block emulation being done in the JCL component.

3172585 (1115455)

If DSNRLI makes a TX call that does not return the expected value, the return code is reported in a
message to the job log and the return code from DSNRLI is 8. The reason code reflects where the issue
occurred.

3171133 (1115345)
Following a TERMINATE IDENTIFY call, DSNRLI now return a return code 4, with a reason ERR-NOT-
IDENTIFIED on a call for the same XA resource until a new IDENTIFY call is made.

3171131 (1115360)
When an SMS DATACLAS is used, the relevant values are now used from the DATACLAS when a new
GDS is created unless explicitly defined otherwise.

3170401 (1115293)
An issue with the spool housekeeping utility (MVSSPLHK), which failed to find some data sets when
ES_ALLOC_EXPAND=N was configured, has been resolved.

3169705 (1115264)
When a the value associated with a PARM within a JCL job is quoted and spans multiple lines, the white
space at the end of the lines is now correctly retained.

3166752 (1114968)
SYSPRINT DD DUMMY is now supported within an IEBPTPCH step.

3166633 (1114931)
The spool file ()-create-date and ()-create-time fields are now correctly populated in the printer exit
interface.

3165857 (1114871)
The console log message MVSER0995U now reports the file status code.

3164710 (1114774)
The 'mfpubcat.inc' PL/I file now contains the same declarations as its equivalent COBOL file
'mfpubcat.cpy'.

3164527 (1114777)
MFCATXML now returns both any records of datasets from user catalogs as well as the main system
catalog.

3162870 (1114667)
An error when deleting a job on the Input queue, which resulted in a SYSZJOBD lock being left, has
been corrected.

3162806 (1115022)
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e The IDCAMS ALTER GDG processing now includes support for the EMPTY|NOEMPTY, SCRATCH)|
NOSCRATCH and LIMIT parameters.

3161965 (1114592)

« If the current highest bias of a GDG is removed outside of a JCL job, for example via the ESMAC
catalog view or the public catalog API, the high bias value of the GDG model is recalculated to reflect
the remaining biases.

3161796 (1114520)
« SHAREOPTIONS settings in a MODEL cluster are now applied correctly to a newly-defined CLUSTER.

3161763 (1114517)

e An RTS114 error, reported when closing down a region containing an allocation override file that
contains an unsupported condition, has been rectified.
3161604 (1114655)

e The missing PL/I include file, mfpubspl.inc, has been added to the product.

3161446 (1114489)

« A failure to create archive catalog records when using spool housekeeping with a user catalog has been
corrected.

3161437 (1114485)

« An issue translating the received FTP file when the working files where under the control of Fileshare
has been corrected.
3160811 (1114484)

« A performance improvement in the job recovery processing has been made by removing some
additional unrequired reading of spool job records.
3156375 (1114147)

* MFFTP now encloses anything that follows a ‘cd' command with double quotes, unless the quotes are
already present.
3154403 (1113925)

« |f the association of an XA Switch module with a unit of work fails, DSNRLI now reports appropriate
error codes for functions that require the association.

3151780 (1113682)
« A security PHYSFILE check is now only performed when the physical file or directory does not exist.

3150380 (1114031)
* A new option for MF_UCC11 processing is how available. Use MF_UCC11_DYNCLEAN=N to prevent
the cleaning of dynamically allocated datasets when restarting a job.

3149990 (1113815)

« Allocation Overrides can be applied to the new path and name of a physical dataset when the IDCAMS
ALTER NEWNAME command is used and the environment variable MF_ PCRENAME_LAX=D is set.
3149083 (1113510)

* Anissue that occurred when submitting JCL jobs using the CICS WRITE API and the Internal Reader
has been fixed. The environment variable ES_CAS_API=0ON is now set automatically in the process
that submits the job.

3148986 (1114840)

» A'Catalog Duplicate Exists' error, reported when creating a new GDG bias and the GDG Model resides
in a user catalog, has been corrected.
3148698 (1113498)

« Afault, reported as 'not found' or ‘attribute mismatch', when using ES_ALLOC_EXPAND=N and
opening a VSAM file, has been corrected.

3144287 (1113057)
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An issue with tab characters in the allocation override configuration file, when the EXTFH configuration
setting EXPANDTAB=OFF is set, has been corrected.

2876194 (1106812)

When a job with a RESTART parameter on the JOB CARD is first submitted, the SYSOUT files will now
have names based on the job submission time rather than the job run time. When a job is restarted, the
new SYSOUT files will have names based on the restart time.

2856323 (1108461)

A catalog error when deleting a dataset from a directory that is also the target of a Dynamic PDS has
been fixed.

VSAM SHAREOPTIONS options are now passed correctly when getting and setting VSAM records
using the public Catalog API, MVSCATPB.

A failure when reading the VSAM file header when a file was under the control of Fileshare has been
fixed.

Removing a lock on a dataset when using mvscatpb now works.

An issue with multiple VSE $$LST entries, where previous entries were being overwritten, has now
been corrected.

3169047 (1115308)

Licensing

Back to the list

cesadmintool.sh now searches for " version" string in the Java version and ignores any additional output
that might appeatr.

3185425 (1116559)

In Docker environments, the license administration program, MFLicenseAdmin, now copes with longer-
than-usual license strings. These occur with longer pieces of customer information embedded in the
license.

3174371 (1115634)
There is no longer an entry in the Uninstall column for licenses installed on remote machines.

3131570 (1112101)

Mainframe Access

Back to the list

MFDAS now supports importing IMS and DB2 types to the local catalog.

3184718 (1116546)
The /CATLOG option on MFDAS commands is no longer ignored.

3131397 (1111830)
MFDAS now correctly respects connection information specified by the caller.
The MFDAS command line now supports submitting QSAM or PDS members remotely.

MFA no longer fails to return information about data sets on extended addressing volumes (EAVS).

3173574 (1115901)

Expanding a job in JES Explorer to view the SYSOUT data sets now also displays the input data sets.
This corresponds to the SDSF INPUT ON command.

3168184 (1115117)
MFA no longer abends if the AUDIT feature is enabled. The AUDITRPT utility has been fixed.

3160243 (1114378)
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MFA no longer shuts itself down after session time-out because of a system wait.

3158778 (1114316)

If an external job gets an enqueue on an Endevor resource while MFA is using it, then MFA no longer
receives multiple abends and halts when the resource is released.

3149517 (1113490)

When an application server job name sequence number reaches the maximum specified number for
that group, the sequence number will wrap to 1.

2860257 (1104402)

SyncMon2 will now display characters correctly when the console output is redirected to a file.

3184737 (1116484)

The MFA server no longer omits the member separator record when performing a bulk member import
for Endevor.

3161685 (1114507)

Syncmon2 GUI has been redesigned to make it easier to understand when adding different types of
sync items. For example, it is now clearer what information is needed when syncing against Endevor.

3147936 (1113476)
ALLOW_REGEX is now optional for all sync types.

3147936 (1113422)

SyncMon2 will now correctly accept EXT= or EXTENSION= for specifying a file extension to be used for
the sync.

3183101 (1116324)

When SyncMon2 was unable to contact MFA Server it would try and print an error message and crash.
This has been fixed and will now correctly display the error message.

3174011 (1115779)
MFA Drag and Drop now supports passphrases of up to 100 characters.

Micro Focus Batch Scheduler Integration

Back to the list
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When MFBSI basic substitution is used, any characters (not just numerics) in cols 73-80 are now
ignored.

3189187 (1116795)

When using MFBSI Basic or Control-M substitution, the submitted resulting JCL file was sometimes
automatically deleted when “Keep-Subst-JCL=NO” was set via an environment variable or in mfbsi.cfg.
This has been fixed.

3188547 (1116737)

When a Control-M %%INCLIB statement using an %%IF/%%ELSE sequence is used in JCL in-stream
data, invalid //*CTM INCLIB is no more outputted in the JCL data.

3183202 (1116321)

The Control-M variable %%JOBNAME takes its value from the JOBname found on the JOB card, and
will now honor variable substitution. In the following example, %%JOBNAME will be resolved to
“TESTQA”.

//* WHSET %%ENV=QA
//TESTY%ENV JOB (101,"ES JCLS"),CLASS=A,
// MSGCLASS=H,COND=(4,LT)

3171321 (1115408)
When using CASAPI, JobNumber for JOBnnnnnnn.log is no longer truncated (to 5 chars).



3153191 (1113827)
« When the Control-M autoEdit facility is used, the character "~" (tilde) is no longer replaced by a space.

3150693 (1113624)

Micro Focus Common Client
Back to the list

» Applications which use the Micro Focus Common Client (MFCC), such as the Interface Mapping Toolkit
(when deploying a COBOL web service or EJB to Enterprise Server), can now specify credentials when
binding to the Micro Focus Directory Server. This provides additional security. If credentials are not
configured, MFCC will use an anonymous bind, as it did in earlier product versions. Credentials are
specified using the mf-client.dat configuration file.

Micro Focus Directory Server
Back to the list

e The Enterprise Server Administration Web Ul will only display user session details if the logged in user
is authorized.

3190235 (1116886)

« Additional Enterprise Server Administration Web Ul server-side checks were added to guard against
non-editable field value changes for started Enterprise Server instances and active security
configurations.

3185626 (1116719)

« Establishing a connection to a TLS-enabled MFDS process if non-default (non-DemoCA) certificates
were used now works as expected.

3174276 (1115675)
« The MFDS journal data format has been enhanced to be platform and bitism independent.

3169565 (1115249)
< Improved validation of data input to Enterprise Server Administration Web UI.

3163386 (1114693)

« Adding or editing TCP listener-requested endpoint values using the Enterprise Server Administration
web Ul so that a port clash may occur now gives a warning rather than being disallowed and treated as
a user input error.

« If the Enterprise Server Administration Web Ul is hosted in a Docker container, the displayed hyperlinks
to reach the Micro Focus Communications Process web pages can now be configured to use an
address which is valid outside the container.

* URLs to SSL-enabled MFCS Control Channel addresses displayed in the Enterprise Server
Administration HTML Ul now use an https prefix.

* Anew field, "Server CA Root Certificate", is available in the Communications Process Control Channel
page (id: c400). The value specified here is used unless the MFDS_server CAROOT environment
variable was specified as it takes precedence. You must specify the server CA root certificate if the
Communications Process Control Channel is SSL/TLS-enabled and if communications with the MFDS
process are required such as to respond to keepalive and any other administration control requests.

« Enterprise Server Administration Web Ul would sometimes display the successful logon splash screen
instead of a logon error message.

« The MFDS process could terminate when copying the definition of an Enterprise Server instance if it
contained a very long description text.

» Trying to view or edit the properties of a Security Manager that is not in the Directory Server Security
Manager list now results in receiving an appropriate warning message instead of an HTTP 404 error.

« MFDS now saves any changes made to the Communications Process immediately instead of at
shutdown.

Resolved Issues
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Micro Focus Server Administrator

Back to the list

If Enterprise Server Administration was set to restricted access, some MQ listener configuration pages
would not be displayed.

3152874 (1113782)
The Enterprise Server Administration HTML Ul no longer displays the IP address but only the host
name used by the Web administration server process.

3140974 (1112912)

OpenSSL
Back to the list

Visual COBOL, Enterprise Server, and Enterprise Developer now include an updated collection of
public Certification Authority root and intermediate certificates (CARootCerts.pem) derived from the
public collection maintained by Mozilla.org.

PL/I Support

Back to the list
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An issue resulting in a SIGSEGV during compilation has been resolved. The compiler is now rejecting
declarations of controlled variables outside of external procedure scope (which Enterprise Developer
does not support yet).

3163627 (1114683)
Programs using SQL code and labels now compile cleanly.

3163626 (1114682)
The PL/I compiler now accepts hamed constants with the BIGENDIAN attribute.

3186448 (1116580)
The optimization problem related to character literals has been fixed.

3185930 (1116534)

An issue which caused a run-time system failure on ALLOCATE <structure with REFER> SET(<offset>)
has been fixed.

3184177 (1116414)

The Open PL/I compiler now supports XML tags using the case of declaration and attributes enclosed
in double quotes. See the new compiler options -xmlcase and -xmlattr. The *PROCESS XML directive is
also supported.

3180475 (1116120)

The Open PL/I compiler now supports new command-line options -dummy aligned and -dummy
unaligned. In addition, *PROCESS DEFAULT(DUMMY (ALIGNED|UNALIGNED)) is also supported.
3180244 (1116091)

An issue with DEFAULT RANGE (*) used in combination with a variable of type OFFSET has been
fixed.

3179782 (1116065)

The NOINIT attribute is no longer ignored.

3179191 (1116008)

An issue causing the compiler to recursively loop during Restricted Expression Evaluation has been
fixed.

3178664 (1116009)



Named constants of numeric PICTURE type are now supported in static structure dimensions and
initializations.

3176071 (1115764)

The PL/I compiler now has increased limits to help prevent occurrences of the diagnostic message
"MFPLIO2012A: Internal IL overflow".

3175119 (1115684)
An issue with the SIZE and STORAGE built-ins returning an incorrect result for elementary data items
of type CHAR ALIGNED has been corrected.

3174904 (1115665)

Comparison of an OFFSET variable with SYSNULL() or NULL() was erroneously producing a diagnostic
message MFPLI00277.

3172702 (1115461)
You no longer receive incorrect error messages when compiling code which includes string array
parameters.

3172570 (1115453)
An issue with the ONCODE built-in used with a condition prefix has been fixed.

3171821 (1115390)
Internal compiler storage limits have been increased to allow for more complex expressions within
DECLARE statements.

3171124 (1115349)

Open PL/I now supports passing structures and arrays using a dummy argument and you no longer
receive an MFPLIO0109S error message.

3165677 (1114857)

The diagnostic message MFPLI00064S now includes the argument number that would help to diagnose
the application code. Any additional diagnostics have been modified in the same way.

3165344 (1114877)
An issue initializing an ENTRY variable having a RETURNS descriptor with an INIT clause has been
corrected.

3165047 (1114792)
An issue where DEFAULT RANGE(*) was applied to descriptors has been fixed.

3164843 (1114799)
You no longer receive a diagnostic message MFPLI04450S when using the WEEKDAY built-in function.

3164263 (1114732)
PL/I now raises a diagnostic message MFPLI004451, "OPTIONS(REORDER) is parsed but ignored".

3163949 (1114779)
*PROCESS OPT(TIME) is now supported.

3163624 (1114681)
The Open-PLI compiler now recognizes PROCEDURENAME and PROCNAME as built-in functions
when parenthesis, (), are not used.

3163166 (1114661)
You could receive compiler errors if a macro generated code that caused a PL/I built-in function name to
be split at the right margin.

3161895 (1114615)

The Open PL/I compiler now diagnoses character-string lengths which exceed the implementation limit
after Restricted Expression Evaluation.

3157748 (1114289)
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* Anissue when using the procedure option BYVALUE with PUT DATA statement has been fixed.

3156065 (1114057)
« A PL/I compiler optimization problem using the compiler options -opt -range causing incorrect execution
behavior has been fixed.

3151588 (1113704)
« The use of condition prefixes no longer causes diagnostic message MFPLI0O4042A.

3151488 (1113713)
* Anissue which caused a message "MFPLI04042A : Possible compiler error" has been resolved.

3151486 (1113705)
< An issue with multiple passes of the macro preprocessor and -margins 2,72 has been corrected.

3150661 (1113721)
* Anissue with text beyond column 72 of a *PROCESS statement as been fixed.

3148585 (1113611)
e Th Open PL/I compiler now supports the INOUT, INONLY, and OUTONLY attributes.

3141132 (1113175)
e The Open PL/I compiler now supports the REM built-in function.

3140471 (1112890)
e The MEMINDEX built-in function is now supported.

3140469 (1112888)
e The ALLOCATE and PLIFREE built-in functions are now supported.

3140465 (1112960)
e The REPLACEBY2 built-in is now supported.

3140463 (1112947)
¢ MEMCONVERT built-in function is now supported.

3140462 (1112866)
e Open PL/I now supports the INDEXR built-in function.

3140461 (1112879)
« ONCONDCOND built-in function is now supported.

3140460 (1112878)
* Open PL/I now supports the BETWEEN, BETWEENEXCLUSIVE, BETWEENLEFTEXCLUSIVE, and
BETWEENRIGHTEXCLUSIVE built-in functions.

3140459 (1112876)
* Named constants in structures are now supported.

3139140 (1112775)
* Open PL/I now supports the HEX built-in with scalar and structure expressions. Restriction: Array
expressions are not yet supported in this context.

3139123 (1112586)
* The GET DATA facility is now supported.

3139120 (1113154)
e The Open PL/I compiler now issues a W-level diagnostic when a bit operator (& |) is applied to a non-
BIT operand.

3137262 (1112381)
e The Open PL/I compiler now generates a Warning-level diagnostic when a character string passed as
an argument is longer than the corresponding parameter descriptor.

3137230 (1112370)
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The Open PL/I source listing map has been enhanced to show array dimension information. In addition,
the listing map has been reformatted from 80 to 132 columns.

3130920 (1111804)
An issue causing the SQL preprocessor to abort has been fixed.

3118614 (1110627)

Previously, if recovering from a hardware generated signal, it was not possible to catch a second
hardware generated signal. This has now been fixed.

2866118 (1105344)
Previously, named constants allowed modification of the named constant when passed by reference.
An issue with using the FREE statement with the IN clause has been fixed.

When debugging applications using the EBCDIC charset, the PL/I debugger in Eclipse did not display
variable values correctly.

3177744 (1115891)
Setting a variable watch on EIBCALEN in a CICS application should now work as expected.

2843455 (1102176)

The PL/I debugger now displays the correct line number when stepping on a statement which has an
existing user breakpoint.

It is now possible to view the output of PL/I applications running on remote machine under X Server,
and to add input to them.

You now receive a message, "<error(s)_during_the_evaluation>" to the value field of a variable, when
the variable name contains an asterisk (*). An asterisk field name is typically not designed to be
addressable or usable. It is not possible for the debugger to evaluate it by name either. See the PL/I
Language Reference in your product Help for more details.

This release supports program breakpoint setting in PL/I programs. In order for breakpoints to work
properly, the name of the shared library for the breakpoint must have the same name as the PROC
statement for the main procedure of the shared library itself. This means that a program breakpoint
request for the shared library FOO must have a primary entry point similar to FOO - e.g. PROC
OPTIONS(FETCHABLE). Also, a file extension in the program breakpoint name is not needed or
supported. To set a program breakpoint for FOO.dIl or FOO.so, you only need to type "FOQ". Name
matching is not case sensitive and all names will be folded to upper case.

This release includes support for breakpoints on executable statements in PL/I include files.

In the Expressions view, if selected, the columns Declared Type and Actual Type now show the type of
the variable or the expression being evaluated.

When debugging PL/I code in Eclipse, a program started from the command line and attached to by the
debugging will be terminated abruptly when you choose Terminate. You need to use the Disconnect
option to enable the application to continue executing after detaching the debugger.

The debugger would crash due to a buffer overflow when trying to evaluate a larger varying variable.
In Eclipse, when starting to debug a non-Enterprise Server based PLI program which caused a stack
check error to be raised, debugging would immediately terminate with message "Program stopped due
to signal 11 segmentation violation". A stack check occurs when the stack needed by a user program
was larger than the current stack that was reserved during the link process. This is now fixed.

When setting an expression on a breakpoint, any CONVERSION conditions which occur when binding
the breakpoint are ignored due to uninitialized storage. This means that the edit might not catch all user
errors entered in an expression value.

Improvements have been made for displaying large variables and structures in the Variables and
Expressions views within Eclipse while debugging PL/I programs.

If your project was missing some DC files, the debugger would still call the DC APl when searching for
an include file id.

When evaluating a referenced variable (p->v) which is a struct member, its latest instance was returned.

Now, the reference is preserved and the correct value is returned.
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« The XMLDEMO example as shipped failed on the call to the PLISAXA API because the events structure
passed to it was not using the required data type of ENTRY LIMITED. The examples have been
updated to match the XML support.

3191102 (1116960)
» This release includes new sample programs for PL/I on UNIX. Refer to the readme file in the $COBDIR/
demo/open-pli directory.

« The source code in the example and other similar variations are now processed correctly.

3177673 (1115886)
< Long path names for include files are now handled correctly.

3148758 (1113423)

« Previously, when the macro preprocessor generated diagnostic MFPP09226E it did not correctly set the
maximum error level upon exit. This has now been fixed.

3181674 (1116183)
e The emulation of the ANSWER built-in function in the Micro Focus Macro Preprocessor now defaults to
a starting position equal to MACCOL.

3180174 (1116113)

» Previously, if invalid syntax for a macro was entered which resulted in a scan forward for a single block
that exceeded 65535 bytes, then the macro preprocessor would fail without issuing a diagnostic
indicating the cause. This no longer happens.

3180037 (1116093)

< When running multiple macro passes using -margins 2,72 against a structure which contains structure
level declarations in column 2, and commas terminating structure elements in column 72, a second
macro pass caused a portion of the data structure to not be present in the output deck.

3178876 (1116005)
« Previously, if emitting preprocessed code within margins 2,72 and a single byte delimiter occurred at
exactly the right margin boundary, then it was erroneously placed in column 73.

3172770 (1115467)
» Closing paren and semi-colons are no longer discarded in complex INIT statements.

3168558 (1115071)

» Previously, the macro preprocessor would not correctly parse a WHEN statement that contained
multiple expressions in which the expressions contained commas. This has now been fixed.
3159116 (1114375)

e The PL/I Macro Preprocessor now supports the DO LOOP and DO FOREVER syntax.

3158083 (1114215)

« Previously, if a macro variable caused the replaced text to be larger than the length of the macro
variable, a %LINE was injected immediately following the next end of line marker. The new %LINE in
now immediately injected after the next semi-colon.

3152196 (1113737)

* Previously, when making an assignment to a file variable prior to establishing an ON unit for the file, and
then attempting a comparison of the file variable to the FILE, the comparison would fail.

3186873 (1116621)
* The enhancement for SI 3175398 (RPI 1115722) was not being honored in some scenarios when the
Open PL/I Run-Time System was not unloaded between job steps in the batch initiator.

3184952 (1116523)
e Anissue where UNDEFINEDFILE was not raised for SYSIN when SYSIN utilized directly for record
input has been fixed.
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3184839 (1116458)

Previously, if a single character value was surrounded by two character references, the single character
would not be emitted to the PLISAXA E15 event.

3179171 (1116017)

Previously, if a PL/I program which executed under Enterprise Server attempted to write to SYSPRINT
DD without a SYSPRINT DD defined you received an error message that indicated FILE=stdout instead
of FILE=SYSPRINT.

3178595 (1115953)

Previously, if using PLISAXA to parse an XML Structure, only attributes that were multiples of five were
passed to the attribute callback routines.

3177690 (1115889)

Previously, if FILE declarations of differing DCB (RECFM, RECSIZE, etc.) were used to OPEN for
OUTPUT the same DD defined in a JCL Jobstream the attributes of the datasets all matched the DCB
of the first FILE opened using that JCL DD.

3175398 (1115722)

DATETIME patterns that previously raised an ERROR condition no longer do so.

3174344 (1115647)

Previously, if code was written which did a GET EDIT into a FIXED BIN variable specifying that the
incoming data was in PIC format, a trap could occur. This has now been fixed.

3168420 (1115138)

Previously, if a PL/I application called a COBOL subroutine and the COBOL subroutine caused a
COBOL Run-Time System Error, the PL/I ON ERROR units were not driven.

3168339 (1115084)
Non-local GOTO statements positioned outside of ON ERROR blocks used to reset the behavior of the
ON ERROR SYSTEM,; statement.

3154846 (1116079)

Previously, the FETCH statement would fail if the TITLE option was used in conjunction with a variable
containing trailing spaces. This has now been fixed.

3152827 (1113779)
Open PL/I now supports dynamic allocations of z/OS datasets utilizing optional expressions in the
TITLE option of the OPEN statement.

3143632 (1112999)

Previously, if operating in a mixed language environment of COBOL and PL/I, if a COBOL program
triggered a hard error such as a SIGSEGV, there was no way to generate a Windows mini dump. See
the documentation for MFPLI_MINIDMP environment variable for directions on how to enable the new
functionality.

3142342 (1112998)
PLIDUMP output can now be configured using PLIDUMP_CONFIG environment variable

3130920 (1111853)
An issue causing the SQL preprocessor to abort has been fixed.

3188874 (1116775)
Execpp has been enhanced to allow very large PL/I statements.

3184447 (1116396)

Previously, if a macro was used to generate a parameter to a CALL statement, the EXEC preprocessor
would erroneously omit an error message indicating that the CALL had mismatched parenthesis.

3177094 (1115846)
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A comment immediately following a quoted string with no intervening characters used to cause an
unbalanced parenthesis diagnostic.

3177085 (1115842)

Previously, when using the EXEC or INCLUDE preprocessors, if the number of %INCLUDE(d) or EXEC
SQL INCLUDE(d) files exceeded 1000 then a severe error message was issued and processing
terminated.

3176715 (1115820)
An SQL variable declaration of type BLOB having an underlying (1) dimension has been fixed.

3174584 (1115631)
Use of CONTROLLED variables in EXEC SQL statements no longer causes compiler failures.

3171842 (1115395)
The DB2 pre-compiler incorrectly generated swap logic for SQLCA numeric fields if not defined in the
main section of PL/I program. This has now been fixed.

3159844 (1114354)

Trying to precompile a PL/I program containing both EXEC SQL and utilizing the PL/I package language
construct produced an error.

3134798 (1112169)

Run-Time System

Back to the list
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Under certain circumstances, if a file was opened multiple times and an error occurred, then any
physical locks on the file could be lost.

3177819 (1116043)

In a threaded environment, when using critical-sections and simultaneously loading/unloading shared-
objects, a race condition would sometimes create a deadlock. This no longer occurs.

3177711 (1116154)
The use of the P(COBSQL) Compiler directive in a Visual Studio or Eclipse project no longer causes the
IDE to crash intermittently at termination.

3133807 (1112077)

The COBRT243 Class could not be loaded error message now contains the name of the class that
could not be found.

3104988 (1109420)

Calls to CBL_MEM_VALIDATE might not have given the full memory corruption details if the corruption
occurred in freed memory. This is now fixed.

When using the Character Animator, you can enter Ctrl+C to interrupt the running process you are
debugging. This would sometimes fail to stop the running process, but should now behave as expected.

When setting the out-length parameter of the CBL_STRING_CONVERT API to zero in order to get the
size of the buffer required for the conversion, the API no longer fails with a ArgumentNullException
when running on the .NET environment. Under JVM COBOL, this API no longer corrupts the output
buffer if the output length has been set to 0.

In managed COBOL, for a very small set of cases for exponentiation and DIVIDE ROUNDED,
performance was very poor. Also, for some of this set of cases, the result of DIVIDE ROUNDED could
round in the wrong direction. These issues have been fixed.

3185807 (1116589)

Within JVM COBOL, a MOVE operation from a COMP-2 item containing a negative value to an
unsigned COMP-5 item now gives the correct result.

3175547 (1115719)



Under JVM COBOL, RunUnit GetEnvironmentVariable() is now case insensitive on look-up of
environment names.

3161925 (1114545)
CALL "SYSTEM" in a JVM COBOL program that is executed from a run unit in Java no longer produces
a COBRT200 error if RunUnitStartupOptions.UseSingleThreadedRuntime is set.

3151448 (1114573)

JVM COBOL only. An issue has been resolved whereby some arithmetic expressions using a binary
item (COMP, COMP-5) that had the value -2147483648 ( - 2**31 ) could result in stack overflow.

Setup Issues
Back to the list

The Data File Tools AddPack can now be installed alongside Enterprise Server.

3158290 (1114230)
The installer error handling has been extended to cater for certain conditions.

3152023 (1113706)

SQL: COBSQL
Back to the list

COBSQL now handles "ELSE EXEC SQL" correctly when it is all on the same line in the source file.

3176046 (1115778)
The XAID option did not work properly for COBSQL when CHARSET(EBCDIC) was used.

3174070 (1115697)
A compilation error that was caused by the COBSQL preprocessor incorrectly handing sections
declared inside of a copybook has been fixed.

3164533 (1116863)
An unreadable copybook caused COBSQL to loop when stacked with the CP preprocessor. This has
been fixed.

3156374 (1114103)
An unreadable copybook caused COBSQL to loop when stacked with the CP preprocessor. This has
been fixed.

3156374 (637041)
An issue that caused a compilation error when COBSQL encountered inline comments in an EXEC
SQL statement has been fixed.

3123025 (1111044)

COBSQL messages have been updated to provide more information when failure is due to a missing list
file, and when the list file is missing due to use of the LTYPE=NONE directive.

2883514 (624749)
To prevent exceeding the COBSQL directive buffer size, the maximum directive buffer size has been
increased to a maximum of 8000 characters.

2852872 (1104084)
To prevent hanging or a compilation error, COBSQL has been updated to properly handle conditional
statements in the same line as EXEC SQL statements.

2804004 (1097225)

An issue that sometimes caused SQL error text to display as truncated on the command line has been
fixed by increasing the maximum error length to 250 characters, and updating the logic used to
construct the message.
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An issue that caused an error when a space was present between an END-EXEC statement and a
period has been fixed.

The COBSQL precompiler interprets the SOURCETABSTOP COBOL compiler directive as
SOURCETABSTOP(8) in all cases. This is due to Pro*COBOL honoring only SOURCETABSTOP(8),
and is a permanent restriction for COBSQL.

SQL: HCO for DB2 LUW
Back to the list

An optional 'FROM' keyword in SQL statements such as 'FETCH FROM <cursor-name>' used to cause
compiler errors.

3191635 (1116976)

There is no longer an issue with negative line numbers being generated in the .bnd file when the
COBOL source file has more than 32700 lines of code.

3188178 (1116814)

An issue with the DB2 preprocessor caused it to incorrectly classify PL/I variables greater than 4000
bytes as LONG VARCHAR when it should have classified PL/I variables less than 32767 bytes as
VARCHAR as it does for COBOL variables. This has been fixed.

3185976 (1116539)

DB2 XA switch source is now shipped for Linux ppc64le platforms.

3184287 (1116424)

The DB2 pre-compiler incorrectly generated a compile error when hyphen was used in SQL command
without a space between the hyphen and host variable name. This has now been fixed.

3180089 (1116102)

DB2 LUW now supports dashes in cursor names, so the DB2 pre-compiler no longer changes dashes
to underscores in cursor names.

3177271 (1115912)

The DB2 pre-compiler incorrectly passed COBOL variable names to PL/l programs when generating
code to handle EXEC SQL SET CURRENT PACKAGE PATH statements.

3175885 (1115744)

The DB2 and OpenESQL pre-compilers now qualify generated code that uses SQLSTATE to qualify
SQLSTATE similar to this one: SQLCA.SQLSTATE.

3173295 (1115512)

An issue that caused the DB2 preprocessor to incorrectly reject FILLER as a valid host variable name in
PL/I programs has been fixed.

3164600 (1114767)

An issue that occurred with user personalization on user names exactly eight characters long has been
resolved.

3156639 (1114163)

When a DBCS database is used with CHARSET(EBCDIC), the data of a char field following a varchar
field will no longer be corrupted.

3155499 (1114065)

SQL: HCO for SQL Server
Back to the list

Resolved Issues

An issue that prevented SQL Server from releasing all resources at the end of a CICS transaction has
been corrected.

3184561 (1116409)



HOCSS applications that use DBRMLIB but are not bound before execution will now report runtime
errors with SQLCODE -808 for all statements executed, and the possibility of a cursor open and
subsequent fetch not returning any errors has been fixed.

3155911 (1114082)
The HCOSS Transfer Data tool user interface has been updated to clarify SQL Server requirements in
cases where the SQL Server versions differ between the server and the client.

An issue that occurred when using read-only WITH HOLD cursors, and when SQL(DBRMLIB) and
SQL(ODBCV3) were both specified has been fixed.

3168191 (1115275)
The OpenESQL runtime has been updated to return a connection error when calling a stored procedure
in a program compiled with the SPCALLLOCAL directive, and no connection exists.

3154238 (1113896)

SQL: MBDT Utilities
Back to the list

There is no longer an issue with using more than one "AND/OR" statements in the WHEN clause for
SQLUTB UNLOAD. An issue with the JCL parser in SQLUTB where parsing JCL input for SQLUTB
UNLOAD has been fixed.

3181572 (1116360)

Space padding to the maximum length no longer occurs when loading EBCDIC data into VARCHAR
fields if the "EBCDIC" option is specified on the LOAD card. The actual lengths of the loaded data are
used in inserting data into the columns.

3179487 (1116036)

An issue with unintentionally submitting a JCL job to run SQLUTB when the XA is disabled has been
resolved. The SQLUTB program now verifies the status of opening the XA connection before it
proceeds.

3178489 (1116084)

In SQLUTB loads, formatted PIC X(8) - PIC X(10) fields that contained char values resembling times
had '.' chars transformed to "' incorrectly. For example, for "99.99.99" the result table would show
"99:99:99". This is now prevented.

3174745 (1115676)
SQLUTB now returns COND CODE 8 (rather than 0) when it encounters an invalid DSN connection.

3169290 (1115166)
An issue that caused an SQLO007N error when loading data into a table with child relationships to
empty tables has been fixed.

3166222 (1115027)
An issue that prevented the SQLUTB utility from extracting views and tables from DB2 LUW has been
fixed.

3163010 (1114645)

When SQLUTB was run with input DD DUMMY, it returned an error message indicating that the input
data had an LRECL of 0. This has been corrected so that SQLUTB now behaves as the IBM load utility,
ignoring the DUMMY input LRECL.

3161957 (1114698)
An issue that occurred when using SQLUTB LOAD without field specifications in the JCL has been
fixed.

3157802 (1114247)
The SQLUTB utility, when run on Linux Red Hat machines, failed to produce meaningful error
messages. This has been corrected.

Resolved Issues
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3155177 (1114016)
There is no longer an issue with using synonyms to load data into the underlying tables for SQL Server
with SQLUTB. An issue with truncating tables via synonyms in SQL Server has been fixed for SQLUTB.

3152952 (1113855)

SQL: OpenESQL
Back to the list
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JDBC now returns SQLCODE=+1 when the fetched value is NULL and NULL indicator is not used.

3191192 (1116953)
Decimal value is now inserted correctly into Oracle DB when DECDEL=COMMA is set.

3189836 (1116947)
An issue that caused performance degradation when using a STATIC cursor has been fixed.

3185894 (1116518)
The OpenESQL run-time now handles the compiler directive SQL(NOAUTOFETCH) correctly.

3177780 (1115994)
OpenESQL has been updated to provide cobrhcedsn64.so for 64-bit only platforms.

3174065 (1116801)

HCOSS now accepts FOR READ ONLY clauses in cursors before FETCH FIRST clauses. This is
undocumented behavior for DB2 z/OS but HCOSS now supports it to ensure mainframe compatibility.

3173586 (1115528)

An issue where WITH HOLD cursors could remain open after an IMS transaction had terminated for
SQL Server, ODBC and PostgreSQL XA resources has been fixed. SQL(NOCHECKDUPCURSOR) can
now be used to override duplicate cursor checking when SQL(DIALECT=MAINFRAME) is used.

3172382 (1115430)

A new SQL directive [NOJALLOWSERVERSELECT supports server-specific SELECT statements that
are not recognized by OpenESQL as valid ESQL SELECT ... INTO statements. This behavior was the
default in Net Express.

3165092 (1114866)

An issue that caused the OpenESQL runtime to incorrectly handle binary parameter markers for PIC
X(n) VARYING host variables has been fixed.

3163759 (1114719)

The SQL Directives dialog box that appeared for .NET project types in the Visual Studio IDE
erroneously omitted the SQL(HSFTRACE) option for DBMAN=ADO. This has been fixed.

3162428 (1114593)

Data type information that was incorrectly mapped by the OpenESQL Assistant caused it to display
column information improperly when using an IBM DB2 ADO.NET provider connected to a DB2 z/OS
data source. This has been corrected.

3161285 (1114478)

An issue that occurred when the SQL BEHAVIOR compiler directive option was set to UNOPTIMIZED
caused the OpenESQL runtime to generate an RTS 114 error when the COBOL application exited. This
has been fixed.

3158065 (1114288)

Problems with SQL Server and PostgreSQL that surfaced when working with large binary columns have
been fixed.

3156215 (1114335)



An issue that caused the OpenESQL preprocessor to generate an incorrect error message when
SQL(DBRMLIB) was not set prior to specifying SQL(VERSION) has been fixed; the OpenESQL
preprocessor now generates the correct error message.

3155275 (1114004)

SQL FETCH ABSOLUTE CURSOR was not returning rows. A COMP position value is now supported in
the SQL FETCH ABSOLUTE/RELATIVE statement and it behaves as expected.

3153738 (1113903)
An issue that prevented HCOSS from correctly handing IS [NOT] DISTINCT predicates has been fixed.

3152630 (1113764)

An issue that caused HCOSS to incorrectly apply QUALIFIERs to common table expression names has
been fixed.

3152008 (1113714)

The DSNRLI function SWITCH TO is now supported for Enterprise Server Mainframe Subsystem
applications using DB2, Microsoft SQL Server, and PostgreSQL.

3151779 (1113680)

An issue that caused HCOSS to incorrectly handle FETCH FIRST ROW ONLY when no literal row
count was present has been fixed.

3151398 (1113734)

An issue that caused the OpenESQL runtime to execute a core dump on exit when the
MEMORY_STRATEGY tunable was set has been fixed.

3142107 (1113077)

A program that contained zoned decimal host variables used in SQL statements and compiled using
charset(EBCDIC) and dialect(MF) sometimes caused a run-time error. This has been corrected.

SQL Option for DB2
Back to the list

The XDB pre-compiler incorrectly generated line and column number information used by the IDE to get
COBOL information about field on EXEC SQL INSERT statements.

3182574 (1116350)

The XDB pre-compiler incorrectly tried to generate interface logic in nested COBOL routines without
checking if a SQLCA copybook was defined. This resulted in an "Undefined ECM error" error message.
This has been fixed.

3168445 (1115099)
An issue caused by an uninitialized stack variable that resulted in a server violation has been fixed.
3168714 (1115237)

A number of XDB components have been enhanced to better implement bulk INSERT/UPDATE/
MERGE statements using both local XDB engines and XDB Link in dynamic and static mode to z/OS
DB2.

3175084 (1115695)

XDB Link has been updated to support the invocation of stored procedures that return multiple result
sets on z/OS DB2.

3168036 (1115315)
A memory leak in DRDA Continue Query Reply Message processing has been fixed.
3160580 (1114426)

An issue that prevented XDB Server configuration from allowing the full length of 16 characters in the
Global Security Location text box has been fixed.

Resolved Issues | 67



3168821 (1115106)

< Anissue with SQL step processing related to CASE expression evaluation that caused the SQL
COALESCE scalar function to return the wrong result has been fixed.

3160595 (1114413)
e Support has been added for the SOUNDEX() and DIFFERENCE() scalar functions.

3155733 (1114043)

e Anissue that caused a buffer overflow when processing a very large UPDATE WHERE CURRENT OF
in the XDB Link has been resolved.

3151725 (1113807)

e An problem with XUTLB (XDB emulation of DSNUTILB) erroneously reporting an invalid isolation level
has been resolved.

3134586 (1112183)
< An issue with join optimization using differing lengths of DECIMAL data has been resolved.

3131870 (1111903)

« Anissue with a scalar query using a DATETIME value returning an error indicating that the value was
invalid has been resolved.

3129637 (1111872)

e Anissue with Query Descriptor mapping when performing XDB Server to Server connectivity has been
fixed.

3112564 (1110514)
* Anissue with an uninitialized stack space causing a thread abend in XDB SQLDA code page
processing has been fixed.

2990360 (1108708)

Web Service Client
Back to the list

* When a generated Web service client executes, an additional optional user-supplied exit program, exit-
http-resp-headers, is now called to provide access to any and all HTTP headers present in the response
message from the service.

3172598 (1115452)

XML Support
Back to the list
¢ XML PARSE now handles "WITH ENCODING" clauses correctly.

3175231 (1115707)
» Data within the CDATA tag is now processed by the managed XML syntax support run-time.

3166588 (1114954)

« XML PARSE did not handle lengthy CONTENT-CHARACTERS correctly which caused the event to be
returned twice.

3162231 (1114582)
« Literals positioned beyond column 72 in the editor are now being handled correctly and compile without
any issues.

3152550 (1114087)

z/Server

Back to the list
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* AWM tools of type "Execute ISPF Command" within the ISPF function package can make use of the
ISPF table TAUTOJOB if the tool submits more than one job via the "Tool Job' method or if the tool
submits a job via the "Tool Job' method and is used in a MassProcessing action.

3151143 (1113669)
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Other Issues Resolved In This Release

The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).
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3177187 (1115851)
3181887 (1116201)
3177661 (1116118)
3134735 (1112201)
3170148 (1115245)
3171080 (1115373)
3161109 (1114775)
3160774 (1114530)
3187599 (1116668)
3176925 (1115833)
2802311 (1097060)
3140337 (1112673)
3175137 (1115685)
3170946 (1115402)
3128586 (1111526)
3105876 (1109394)
2990180 (1108737)
2854004 (1103682)
2851622 (1103230)
2844942 (1102368)
2841043 (1102369)
2590883 (1085717)
3181941 (1116211)
3103315 (1109252)
2990950 (1108778)
2865338 (1105207)
2597474 (1088223)
3164898 (1114811)
3150507 (1113583)
3122080 (1110968)
3122020 (1110949)
3114654 (1110269)
2887726 (1108356)
2885799 (1108108)
2873642 (1106416)
2835954 (1101265)
2795293 (1096771)
2652488 (1090826)
2587952 (1086146)
3123593 (1111108)
2642528 (1090004)
2594601 (1086032)
3181445 (1116188)
3168020 (1115032)
3164533 (1115215)
3162064 (1114546)

Other Issues Resolved in This Release

3158311 (1114231)
3158072 (1114399)
3141381 (1112770)
3164533 (1115570)
3193749 (1117140)
3158936 (1114346)
3156405 (1114097)
3152246 (1113749)
3157702 (1114217)
3157956 (1114290)
3127953 (1111577)
3159456 (1114310)
2867519 (1105516)
3191105 (1116958)
3174042 (1115569)
3176098 (1115962)
3172981 (1115501)
3127698 (1111446)
3189442 (1116934)
3188582 (1116744)
3178509 (1115958)
3160759 (1114427)
3150188 (1113906)
3177187 (1115851)
3181887 (1116201)
3177661 (1116118)
3134735 (1112201)
3170148 (1115245)
3171080 (1115373)
3161109 (1114775)
3160774 (1114530)
3187599 (1116668)
3176925 (1115833)
2802311 (1097060)
3140337 (1112673)
3175137 (1115685)
3170946 (1115402)
3128586 (1111526)
3105876 (1109394)
2990180 (1108737)
2854004 (1103682)
2851622 (1103230)
2844942 (1102368)
2841043 (1102369)
2590883 (1085717)
3181941 (1116211)

2990950 (1108778)
2865338 (1105207)
2597474 (1088223)
3164898 (1114811)
3150507 (1113583)
3122080 (1110968)
3122020 (1110949)
3114654 (1110269)
2887726 (1108356)
2885799 (1108108)
2873642 (1106416)
2835954 (1101265)
2795293 (1096771)
2652488 (1090826)
2587952 (1086146)
3123593 (1111108)
2642528 (1090004)
2594601 (1086032)
3181445 (1116188)
3168020 (1115032)
3164533 (1115215)
3162064 (1114546)
3161964 (1114569)
3158311 (1114231)
3158072 (1114399)
3141381 (1112770)
3164533 (1115570)
3193749 (1117140)
3158936 (1114346)
3156405 (1114097)
3152246 (1113749)
3157702 (1114217)
3157956 (1114290)
3127953 (1111577)
3159456 (1114310)
2867519 (1105516)
3191105 (1116958)
3174042 (1115569)
3176098 (1115962)
3172981 (1115501)
3127698 (1111446)
3189442 (1116934)
3188582 (1116744)
3178509 (1115958)
3160759 (1114427)
3150188 (1113906)




. 3161964 (1114569) . 3103315 (1109252) . 3187219 (1116640)
« 3172126 (1115445)
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Unsupported Functionality

This section includes information about features or functionality that are no longer supported.

« The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
This is a change since version 3.0 of this product.
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Installation

Before Installing

Downloading the Product

1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

On Windows

System Requirements

Hardware Requirements

Enterprise Developer has the following requirements in addition to the requirements of Eclipse. See the
Eclipse documentation for details of its requirements.

In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM though Micro Focus recommends at least 4GB of RAM for optimal performance.

The disk space requirements for Windows are, approximately:

Enterprise Developer

3.5GB

Note: The disk space requirements include the size of the Eclipse IDE and the version of Java and
the .NET Framework provided with the Enterprise Developer setup file. This includes the space
needed to cache information locally so that you can modify the installation without the original source
media.

z/Server requirements
z/Server has the following hardware requirements:

« IBM mainframe model zEC12 or later is required for installing and using MFA Server. If your hardware
does not meet these requirements please contact Micro Focus support.

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

i Note:

» Support for development on Windows 8 and Windows Server 2012 has been discontinued. These
platforms are still supported for deployment. Windows 8.1 and Windows Server 2012 R2 are
supported.
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Installation

» Enterprise Developer installs fully only on 64-bit Windows platforms. On 32-bit Windows, the setup
file does not install some of the components. See Issues with the Installation in Known Issues and
Restrictions.

» Enterprise Developer enables you to produce both 64-bit and 32-bit applications on 64-bit
operating systems.

» This product can be installed on earlier versions of Windows but it has not been tested on them.

Software requirements
i Note: This product includes OpenSSL version 1.1.1b.

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

Eclipse requirements

The setup file installs Enterprise Developer and the 64-bit Eclipse 4.8.

Some earlier versions of Eclipse are also supported. See Installing Enterprise Developer into other
instances of Eclipse in the Advanced Installation Tasks.

Enterprise Developer installs fully only on 64-bit Windows platforms. On 32-bit Windows, the setup file
does not install some of the components. See Issues with the Installation in Known Issues and
Restrictions.

Enterprise Developer supports both the 32-bit and the 64-bit Eclipse. You can use the 64-bit Eclipse to
create both 32-bit and 64-bit applications.

Software requirements on Windows

Java 8 (64-bit) is required to run the Eclipse IDE. The minimum recommended version is
AdoptOpenJDK's OpenJDK 8 (u202) with Hotspot, which the Windows product installs automatically.
Java 8 (32 or 64-bit versions), and Java 11 (64-bit version only) are supported for executing JVM
COBOL code and for native COBOL and Java interoperability. You can download AdoptOpenJDK's
OpenJDK 8 with Hotspot from AdoptOpenJDK's Web site and unpack the archive anywhere on your
machine.

f Note: Eclipse does not run using Java 11.

Enterprise Developer requires:

* A 32-bit Java installation if using the 32-bit Eclipse.
* A 64-bit Java installation if using the 64-bit Eclipse.
The setup file also installs Microsoft's Visual C++ 2012, 2013 and 2017 Redistributables.

See Java Support Restrictions in the product help for any considerations when using Eclipse and Java.

Other Requirements

Important: For local servers, you do not need to install the Micro Focus License Administration tool
separately, as the setup file installs a new Enterprise Developer client and a new licensing server on
the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool .sh.


http://www.microfocus.com/docs/links.asp?vc=adoptopenjdk

If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled
before the product installation or upgrade can continue.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.
Supported Third Party Software

The table below lists some of the software requirements and Third Party Software this product is tested
with.

For full details on the supported software, see Software Requirements and Additional Software
Requirements in this product's install notes.

Software Requirements

Integrated Development Environment Eclipse 4.8 - installed with Enterprise Developer.
Eclipse 4.7 is also supported.”
Java 64-bit Java 8 is required for running Eclipse.

Java 8 (32 or 64-bit versions), 11 (64-bit only) is
supported for running applications.

Java application servers Tomcat 9.0
JBoss EAP 7.1
Oracle WebLogic 12c R2
IBM WebSphere 9.0
Relational databases Oracle 12c R2 and 18c
Microsoft SQL Server 2012, 2014, 2016 , 2017
IBM DB2 10.5,11.1
Postgres 10.5

MySQL 5.7
Middleware IBM's MQ series 8.0
Platform support See http://supportline.microfocus.com/prodavail.aspx.

* See Installing into other instances of Eclipse in your Product Help.

Additional Software Requirements on Windows

To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file.

Click here to see this information on the Product Documentation pages on Micro Focus SupportLine.

Product Co-Existence
y Note: The following applies to Windows only.

» Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same
machine.

« Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE
(Visual Studio or Eclipse) you install.

Installation Restrictions and Requirements

Before starting the installation you should consider the following:

Installation
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Visual COBOL and Enterprise Developer cannot coexist on the same machine.

You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator

privileges.

On UNIX

System Requirements for Micro Focus Enterprise Developer UNIX
Components

Hardware Requirements

The disk space requirements for Micro Focus Enterprise Developer UNIX Components are approximately:

Platform Installer type Setup Disk space Disk space Sentinel RMS
file size required for required for license
the installation running server
the product

POWER Micro Focus 533 MB 2.13GB 1.07 GB 41 MB

running AIX

HP IA Micro Focus 953 MB 3.81 GB 1.90 GB 79 MB

System Z Micro Focus 425 MB 1.70 GB 850 MB 39 MB

running Red

Hat Linux

x86-64 Micro Focus 540 MB 2.16 GB 1.08 GB 50 MB

running Red

Hat Linux

ppc64le Micro Focus 303 MB 1.21 GB 606 MB 1MB

running Red

Hat Linux

SPARC Micro Focus 519 MB 2.08 GB 1.04 GB 38 MB

running

Solaris

x86-64 Micro Focus 472 MB 1.89 GB 944 MB 33 MB

running

Solaris

System Z Micro Focus 306 MB 1.22 GB 612 MB 39 MB

running SUSE

SLES

x64 running Micro Focus 384 MB 1.54 GB 768 MB 50 MB

SUSE SLES

ppc64le Micro Focus 272 MB 1.09 GB 544 MB 1MB

running SUSE
SLES

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus

SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
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Software Requirements for Micro Focus Enterprise Developer UNIX Components

These are the software requirements for Micro Focus Enterprise Developer UNIX Components:

The "awk", "ed", "sed" and "tar" utilities must be installed and added to the PATH.

The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems

but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.
Required libraries for Red Hat and SUSE Linux platforms - The installer checks that both the 32-bit and
64-bit libraries listed below are installed on both 32-bit and on 64-bit Operating Systems for this product
to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before

you start the installation.

Library

32-bit
Library
Name

64-bit
Library
Name

Platform

s390

SUSE 12

Red Hat 6x

Red Hat 7

glibc
libgcc
libstdc++

glibc-locale

glibc-devel

elfutils-libelf

libelf-devel

libelf-devel

libelfl

gcc?

cpp?
1d2

glibc-
*.i686

libgce-
*.1686

libstdc+
+-*.i686

glibc-
locale-3
2bit

glibc-
devel-
*.i686

elfutils-
libelf.i38
6 or
elfutils-
libelf.i68
6

elfutils-
devel.i3
86 or
elfutils-
devel.i6
86

libelf-

devel-3
2bit-0.1
37-8.19

libelf1-3
2bit-0.1
37-8.19

gcc*.i68
6

Binutils*
.i686

glibc-
*x86_64

libgce-
*.x86_64

libstdc++-
*x86_64

glibc-locale-2

glibc-devel-
*x86_64

elfutils-
libelf.x86-64

elfutils-
devel.x86-64

libelf-
devel-0.137-
8.19

libelf1-0.137-
8.19

gcc*x86_64
cpp*x86_64

Binutils*x86_
64

glibc-*.s390

libgce-*.s390

libstdc++-
*.5390

glibc-devel-
*.s390

N/A

N/A

N/A

N/A

X

X

X
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e 10n SUSE 12, you can only install the 64-bit version of Enterprise Developer. The glibc-locale-32bit
library is still required by the SafeNet Sentinel licensed components.

< * Additional libraries required to use the core_on_error runtime variable. The gdb packages (for the
GNU Project Debugger) can be installed from the install media for your OS.

e ** Qperating system libraries required for PL/l support on both SUSE and Red Hat.

« 20n Red Hat, these libraries are required to enable COBOL and PL/I to compile.

« Libraries marked with an 'X' are not included in the platform and need to be installed separately.

Visit the Red Hat Web site for more information.

Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

Java 8 (64-bit) is required to run the Eclipse IDE. The minimum recommended version is
AdoptOpenJDK's OpenJDK 8 (u202) with Hotspot, which the Windows product installs automatically.
Java 8 (32 or 64-bit versions), and Java 11 (64-bit version only) are supported for executing JVM
COBOL code and for native COBOL and Java interoperability. You can download AdoptOpenJDK's
OpenJDK 8 with Hotspot from AdoptOpenJDK's Web site and unpack the archive anywhere on your
machine.

i Note: Eclipse does not run using Java 11.

Java 8 (64-bit) is required to run the Eclipse IDE. The minimum recommended version is
AdoptOpenJDK's OpenJDK 8 (u202) with Hotspot, which the Windows product installs automatically.
Java 8 (32 or 64-bit versions), and Java 11 (64-bit version only) are supported for executing JVM
COBOL code and for native COBOL and Java interoperability. You can download AdoptOpenJDK's
OpenJDK 8 with Hotspot from AdoptOpenJDK's Web site and unpack the archive anywhere on your
machine.

y Note: Eclipse does not run using Java 11.

f Note:

e On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. If you install IBM's JDK 8, on AlX you must install its latest fix - JDK 8
SR5 FP16. You can get IBM's AIX JDK from IBM's Web site.

¢ On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.

* On Solaris platforms (both SPARC and Intel) only the 64-bit version of Java 8 and later is
supported.

To execute JVM COBOL code, you need to set the environment as follows:

* You need to set the JAVA_HOME environment variable. When installing the product, set this variable
to a 64-bit Java installation or the installation terminates. For example, execute the following:

export JAVA HOME=j ava_install _dir

where java_install_dir is the path to the JAVA installation directory such as Zusr/java/javan. n
* You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_ HOME/bin:$PATH

* You need to set the LANG environment variable to pick up localized messages. The LANG settings
are English and Japanese only.

GNOME menus and buttons have been standardized across all applications so that icons are not
displayed by default. To keep the icons and the look and feel of previous versions, enable the
menus_have_icons property with the command:

gconftool-2 --type boolean --set /desktop/gnome/interface/menus_have icons
true


http://www.microfocus.com/docs/links.asp?nx=redhat
http://www.microfocus.com/docs/links.asp?vc=adoptopenjdk
http://www.microfocus.com/docs/links.asp?vc=adoptopenjdk
http://www.microfocus.com/docs/links.asp?nx=ibmsupp
http://www.microfocus.com/docs/links.asp?vc=hp-home

Additional Software Requirements for Micro Focus Enterprise Developer UNIX Components

To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file.

Click here to see this information on the Product Documentation pages on Micro Focus SupportLine.
UNIX and Linux Installer Issues

Installing on Linux

On Linux, the RPM installer for Enterprise Developer for Eclipse installs a 64-bit version of Java. When you
start the installation, if the 32-bit version of Java is already installed on your Linux machine, you might not
be able to install Enterprise Developer. This is a known issue with the Oracle Java installers for Linux which
prevents you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work
around this problem:

» Download the 64-bit Java distribution in a compressed .tar format from the Oracle Web site.
* Untar the distribution into a location different from the one used for the 32-bit Java version. For example,
untar in Zusr/local/java64 and not in Zusr/local/java.

e Set JAVA HOME and LD_LIBRARY_PATH to the 64-bit version of Java so that it is used to install and
run Enterprise Developer.

Installing while using AFS/Kerberos authentication

If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Enterprise Developer components of the product can use. This user
ID must be set up prior to running the installer. When running the installer you need to specify -
ESadminlID=[ User | D] on the command line so it is used by the installer.

License Server
You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the /etc/hosts file:
127.0.0.1 localhost.| ocal domai n localhost

I P machi nel onghost name machi neshort host name

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation

The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations and for installing the mainframe components, see Advanced Installation Tasks in your
product Help.
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Installing on Windows

i Note:

» This version of the product is a full install.
» If you have an earlier version of Enterprise Developer installed on your machine, check Installing
as an Upgrade before you start the installation - see Advanced Installation Tasks.

These are the steps to install Enterprise Developer:
1. Runthe ede_50.exe file and follow the wizard instructions to complete the installation.

By default, this installs Enterprise Developer in the %ProgramFi les(x86)%\Micro Focus
\Enterprise Developer folder and installs a full version of Eclipse 4.8 64-bit, with the Micro Focus
plugins already installed, in the C:\Users\Public\Micro Focus\Product Nane\eclipse
directory.

The setup file installs any missing prerequisite software as listed in the topic Software Requirements.

f Note: See Advanced Installation Tasks for information about non-default installation tasks.

Installing Micro Focus Enterprise Developer UNIX
Components

Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:
chmod +x setup_entdev_5.0 pl atform

2. Run the installer from the Process User ID login:
-/setup_entdev_5.0 platform

When the installer starts it will prompt you to enter the superuser password so it can perform operations
that require root permissions.

The COBOL environment is installed by default into Zopt/microfocus/EnterpriseDeveloper,
(COBDIR).

SafeNet Sentinel considerations

« The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

-/setup_entdev_5.0 pl at f or m -skipsafenet

« To protect the SafeNet Sentinel installation from accidental updating you can create an empty file

named SKIP_SAFENET _INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET INSTALL
While the file is present, the SafeNet installer does not make changes to the installation or shutdown the

running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.



i Note:

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

Advanced Installation Tasks

This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.

The advanced installation tasks include:

Installing as an Upgrade - included in these Release Notes

Command line installation options - included in these Release Notes

Installing using an RPM installer on Linux - available in the product Help and on the Product
Documentation pages on Micro Focus SupportLine

Installing and licensing Micro Focus Rumba - available in the product Help and on the Product
Documentation pages on Micro Focus SupportLine

Installing into other instances of Eclipse - available in the product Help and on the Product
Documentation pages on Micro Focus SupportLine

Installing the Mainframe Components, - Mainframe Access Server, Application Workflow Manager into
IDz, z/Server - available in the product Help and on the Product Documentation pages on Micro Focus
SupportLine

Installing on Microsoft Terminal Server and Citrix - available in the product Help and on the Product
Documentation pages on Micro Focus SupportLine

Click here to see this information on the Product Documentation pages on Micro Focus SupportLine.

On Windows

Installing as an Upgrade

Installing this release as an upgrade will automatically uninstall any Patch Updates of the older version of
the product you have installed on your machine.

If you have been using the mainframe components of Enterprise Developer for z Systems, see Installing
z/Server as an Upgrade for recommendations about how to upgrade your z/Server installation. Also,
check Backward Compatibility of AWM Models for information about changes that affect your existing
AWM models.

Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.
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Enterprise Developer Installation Options

You can install Micro Focus products silently by specifying /q at the command line and using command line
parameters to specify the installation directory (instal Ifolder=pat h), user information, and which
features to install. You must execute the command with superuser permissions.

To see what parameters you can use, execute the following from the command line:
install-file Zhelp

where install-file for the following products is as follows:
Enterprise Developer ede_50.exe

See the Examples section further in this topic for examples of some of the parameters you can use.

Directory considerations

« You must have read and write access for every directory accessed during the installation.
* You can override the default installation folder using the Instal IFolder parameter.

» Installing creates a group of log files prefixed Micro_Focus__in the %temp% folder, by default. To
change the location or name, use the /log parameter on your Setup command line and specify the
path and file name, for example:

/log drive:\path\LogFi | enane

Installing silently
Use the /g parameter to install silently:

start /wait install-file.exe /g [paraneters]

Examples

« To silently install Enterprise Developer into a directory other than the default:
start /wait ede 50.exe /q InstallFolder=c:\DirectoryName

« If you want to silently install the Eclipse IDE in a location other than the default, execute:
start /wait ede 50.exe /q InstallFolder2=c:\EclipselnstallDirectory

« To silently install Rumba+ Desktop during the silent install of Enterprise Developer:
start /wait ede 50.exe /q RumbaCheckbox=1

On UNIX

Installing as an Upgrade

This release works concurrently with the previous version of Micro Focus Enterprise Developer UNIX
Components, so you do not need to uninstall it.

Install the latest version in a different location and set the environment to point to it. To do this, run the
Micro Focus Enterprise Developer UNIX Components installer with the —installlocation option:

1. Execute the following command:
/lnstall File -installlocation="/opt/microfocus/EnterpriseDeveloper"
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i Note: You can use variables when specifying an absolute path for —instal l location. For
example, the following examples are equivalent:

-installlocation="/home/myid/i nstal | di r"
—-installlocation=""$HOME/i nstal | di r **
2. Execute cobsetenv to set the environment and point to the new install location:
- <product-install-dir>/bin/cobsetenv

Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Micro Focus Enterprise Developer UNIX Components Installation
Options

Installing into a different location

To install in a different location use the —instal Il location=""Location' parameter to specify an
alternative directory location. For example:

-/setup_entdev_5.0 pl atform -installlocation="full path of new | ocation"

i Note: You can use variables when specifying an absolute path for —instal l location. For
example, the following examples are equivalent:

-installlocation=""/home/myid/i nstal | di r ™
—-installlocation=""$HOME/i nst al | di r **

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.

Configuring the Enterprise Server installation

You can use the following options to configure the Enterprise Server installation: [ -ESsysLog=""Y/N"" ]
[ -ESadminID=""User I D" ] [ -CASrtDir="| ocation"™ 7], where:

-ESsysLog Use this to enable ("Y") or disable ("N") Enterprise Server system logging. Logging is
enabled by default. Log files are saved in /var/mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, ~-ESadminID=""esadm". The default user ID is the one that runs the installer.

-CASriDir  Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir=""/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux. You need to execute
the commands as root:

—silent -lacceptEULA

For example, execute:
setup _fil enane —silent -lacceptEULA
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Installing on Microsoft Terminal Server and Citrix

Note: This document is a work-in-progress. Check the documentation for Enterprise Developer in the
Product Documentation section of the Enterprise Developer SupportLine Web site for its most recent
version.

Microsoft Terminal Server and Citrix (TS/Citrix) are environments for running multiple instances of a single
user product. They are not platforms where a single-user product can be made to perform as a multi-user
product.

When running Enterprise Developer on TS/Citrix machine, there might be some implications to
components of Enterprise Developer which could cause potential conflicts between a ‘per-user session’
compared to the standard ‘per machine’ setup. The following components of Enterprise Developer require
special configuration:

« Eclipse workspaces and projects
e The Enterprise Server component - the Run-Time System product for JCL, CICS and IMS operations
* The database management service

You can use Enterprise Developer with TS or with any Citrix version certified for use with Eclipse; however,
a separate end-user license is required for each user who accesses Enterprise Developer, even if it is
running on a single machine. See your End User License Agreement for clarification.

Note: Micro Focus Enterprise Developer does not officially support TS/Citrix. However, it will run on
any prerequisite Operating System that is supported under TS/Citrix.

Capacity planning

Multi-user capacity planning for TS/Citrix does not scale linearly, and the calculations required for this
planning are not directly related or specific to any Micro Focus technology. Micro Focus recommends that
you consult with Microsoft or Citrix Systems, respectively, about the server sizing and capacity planning,
based on hosting the required number of “rich” Windows 7 or Windows 8 desktops (e.g. using a singleton
desktop build as a baseline).

Installing Enterprise Developer
To install Enterprise Developer for use with TS/Citrix:

1. Log on to the physical terminal or Citrix server with a user ID that has administrator privileges.
2. Use the download links in your Electronic Product Delivery email.
3. Follow the links for the installation instructions and the End User License Agreement.

Configuring Enterprise Developer

Follow the links below for details on how to configure the individual Enterprise Developer components.

Customizing the Installation, the Workspace and the Projects

Using Enterprise Developer for Eclipse under TS/Citrix
For considerations about how to use Eclipse under TS/Citrix refer to the Eclipse product help.

Micro Focus recommends you set up Enterprise Developer for Eclipse so that each user has their own
configuration area and you make the configuration folder within the Eclipse installation read-only.
(Enterprise Developer for Eclipse is installed on the TS/Citrix machine into %ProgramFi les(x86)%
\Micro Focus\Enterprise Developer with the Eclipse installation stored in C:\Users\Public
\Micro Focus\Enterprise Developer\eclipse.)

To ensure that each user will have their own configuration area, you need to set up Eclipse as follows:


http://help.eclipse.org/luna/topic/org.eclipse.platform.doc.isv/reference/misc/multi_user_installs.html?resultof=%22%6d%75%6c%74%69%2d%75%73%65%72%22%20%22%69%6e%73%74%61%6c%6c%73%22%20%22%69%6e%73%74%61%6c%22%20

1. On the TS/Citrix machine, start Enterprise Developer once, make any required customizations to the
IDE and then close it.

2. Using Windows Explorer, navigate to C:\Users\Public\Micro Focus\Enterprise Developer
\eclipse and open the eclipse. ini file with an editor.
3. Add the following code before the -vmargs entry:

-configuration
@user .home\EclipseConfig

4. Using Windows Explorer, navigate to the Eclipse installation folder and from the folder properties make
the configuration folder Read Only for the group that will work with Enterprise Developer for
Eclipse.

This ensures that each user that starts Enterprise Developer for Eclipse under TS/Citrix can only see their
own workspaces and that they have their own Ecl ipseConfig folder specified by the eclipse. ini file.

Eclipse workspaces

An Eclipse workspace is a folder on the disk where the project and application files are stored. The default
location for an Eclipse workspace is in the user's area (for example, c:\users\user nane\). It is not
possible to share workspaces so each user must have their own.

We suggest that you create Eclipse workspaces in an area on a shared network drive, naming each
workspace folder with an individual user ID.

Also provide a startup script that maps the drive dynamically using share names derived from the user ID.

| Tip: Use the net use command to connect to, remove and configure the connections to the mapped
[ =] .
= drives.

Template projects

Create and configure template projects to distribute among your users. Templates must not include fully
qualified paths. You can store the projects in a source control system and make them available so that
individual users can import them into their own workspace.

Enterprise Server Installation Options

When you install Enterprise Developer, the setup file also installs the Enterprise Server component on the
same machine. There are different ways in which you can configure and use Enterprise Server regions in
TS/Citrix environments. This topic outlines two of the methods and explains what the implications of
choosing them are:

« Use the Enterprise Server component as part of Enterprise Developer installed on the TS/Citrix
machine

* Install Enterprise Server or Enterprise Test Server on a separate server

Use the Enterprise Server component as part of Enterprise Developer installed on the TS/Citrix
machine

On the client machines, the developers each use a clone of Enterprise Developer. They also use a clone of
Enterprise Server to create and manage multiple server instances as required.

While this option provides the greatest flexibility, it also consumes the largest footprint per user.
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Install Enterprise Server or Enterprise Test Server on a separate server

You can install Enterprise Server? or Enterprise Test Server3 on a separate server that does not have TS/
Citrix installed. By default, Enterprise Server installs and runs as a single-instance product and, within an
Enterprise Server, you can operate a number of server instances. Each server provides session and state
management for COBOL applications, as well as optionally interfacing with external resource managers to

coordinate resource updates.

There are two ways to provide server instances to the developers using Enterprise Developer on the TS/
Citrix machine:

« Configure and configure one server instance per developer by specifying different ports. We
recommend defining five-digit port numbers where digits one through three identify the developer and
four through five identify a unique port. For example: port number 10123 defines a TN3270 listener for
developer 1, and port number 10223 defines a TN3270 listener for developer 2.

Installation

Micro Focus Enterprise Server provides full application server support for COBOL applications that require
high-performance and mainframe subsystem emulation. Enterprise Server is designed as a multi-user
environment.

Micro Focus Enterprise Test Server is an IBM mainframe application test execution environment on
Windows. Enterprise Test Server enables mainframe IT organizations to perform a variety of pre-production
testing on low cost commaodity hardware, avoiding unnecessary cost and delay. Built on proven technology;,
Enterprise Test Server exponentially expands the test capacity and enables testing to scale up easily to
meet delivery timelines and quality standards driven by today's business requirements.



This option provides a dedicated enterprise server for testing purposes for each developer, but restricts
each developer to that one enterprise serve instance.

This scenario creates the largest footprint per developer.

Or:

« Create and configure one server instance per application for use by a single development team. Use a
different port number for each instance as explained above, using the first three digits to differentiate
between applications.

Client machines using clonss
of Enterprise Developer,

_ Enterprise Server and These connect to Enterprise

Entesprise Server on a Micra Focus Rumba Sarvar reglons created on tha
saparats server separale ssrver.

=pie e

T5/CiHrix server with:
Enterprise Developer,

Enterprige Server regions

Configuring SQL Option for DB2 (XDB) for Multi-User Environments

SQL Option for DB2 in Enterprise Developer supports scenarios where multiple users use a single XDB
Server installed on a TS/Citrix server. Typically, users in such environments would require their own private
working locations so they can be isolated from each other's activity on the TS/Citrix server and might
require different XDB configuration settings. SQL Option for DB2 provides support for this.

The configuration options for XDB Server are stored in the xdb . ini configuration file installed in the
Windows protected area in C:\ProgramData\Micro Focus\Enterprise Developer\mfsqgl\cfg.

xdb . ini contains both client-side and server-side settings for the XDB tools.

Changing the server-side settings

In most cases, it is not necessary to change XDB Server's server-side settings. If you need to change
these settings, however, it is important that you use the XDB tools to modify the xdb. ini file as the tools
run with administrator's privileges. This helps avoid some possible issues with Windows virtualizing files in
the protected areas that you try to edit without administrator's privileges.
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See Changing the Main XDB Server Configuration File.

Changing the client-side settings

In multi-user environments such as TS/Citrix, it is important to provide individual users with their own client-
side configuration options for XDB. To cater for that, Enterprise Developer provides a utility, XDBSetup,
which creates a private XDB configuration file for each user in their local Windows folder on the TS/Citrix
machine.

Users would run XDBSetup before they start using any of the XDB components on the TS/Citrix server.
They can then use the XDB Client Options utility (XOPT40N) to customize their own version of xdb. ini
and specify any required client-side run-time options and a temporary space for the client-side tools. For
example, they might want to customize various options such as the isolation level, the lock timeout (for
example, if they want a longer record lock timeout for testing), the data formats (if they want a different date
format to test the software for internationalization issues), the SQLWizard configuration, and the private
area for saved files.

XDBSetup also creates some entries in the user's specific area in the registry which point to the location of
the private xdb . ini file. This ensures that XDB Server will use the main xdb . ini file installed under the
c:\ProgramData folder, while any of the XDB tools that individual users start will use the private

xdb . ini files that users might have customized according to their own preferences.

See Creating a Private XDB Configuration File in a Multi-User Environment.

Configuring the private XDB Server options in batch

If all users must have the same environment and use a specific standard set of client-side options in their
private xdb . ini files, a system administrator can set this up for them using a batch file. The batch file
would execute XDBSetup to create the private xdb. ini files and then it would execute BOPT40N, the
batch version of the XDB Client Options utility, to specify the same client-side options in each private
xdb.ini file.

See Changing the Private XDB Server Configuration Files in Batch.

Creating a Private XDB Configuration File in a Multi-User Environment

Before using XDB Server on a TS/Citrix machine, all users must first run the XDBSetup utility to create a
private XDB Server configuration file, xdb . ini, in their local Windows folders.

To run the utility:

1. Log in to the TS/Citrix machine using the Windows Remote Desktop Connection.
2. Execute the following from an Enterprise Developer command prompt:
XDBSetup

See Syntax of the XDBSetup command for more details.

This creates a standard xdb . ini file in the user's Windows home directory, in c:\Users\user nane
\AppData\Roaming\Micro Focus\Enterprise Developer\mfsqgl\, for which the user does not
need administrator's credentials to change the file.

This also creates some registry entries in the user's specific area which point to the location of the private
xdb. ini file. When any of the XDB tools are executed, they check the user's registry settings for whether
there is a private configuration file before they check the local machine registry settings which store the
location of the main XDB Server configuration file.

Syntax of the XDBSetup command

The XDBSetup utility can run in either an interactive or unattended mode. Use the following syntax to
execute the utility:

XDBSetup [-u]--unattended]



Where you can specify the following options:

No options XDBSetup executes in an interactive mode. You receive some pop-up windows
confirming whether the operation completed successfully, prompting whether to
overwrite a previously installed xdb . ini, and possibly showing any status or error
messages.

-u, --unattended XDBSetup executes in an unattended mode.
Log files:

1. Alog of the commands activity is output to the standard error output handle.

2. If you need to receive any standard errors, specify ">" to redirect the standard output. To redirect any
standard errors, use "2>" as a redirection symbol. If this is not specified, any messages are displayed in
the command prompt.

Changing the Main XDB Server Configuration File

The XDB Server configuration file, xdb . ini, is installed in a Windows protected location - in C:
\ProgrambData\Micro Focus\Enterprise Developer\mfsql\cfg, by default. You need
administrator's privileges to edit the file to help avoid some problems that Windows file virtualization can
cause.

Micro Focus recommends that you use the XDB tools to edit xdb. ini because the XDB tools include a
Windows manifest that requests administrative credentials for updating files in the Windows protected
areas. You need to run the tools from the command line and specify xdb. ini as an argument. For
example, if you use the XDB Client Options utility, execute:

XOPT40N /i1"C:\ProgrambData\Micro Focus\Enterprise Developer\mfsgl\cfg\xdb.ini"

Avoiding Windows virtualization issues

Files that reside in the Windows protected locations, such as xdb . ini, that reside in the Windows
protected locations require that you edit them with administrative privileges. If you use utilities such as
Notepad that do not request administrator's credentials, Windows file virtualization does not save the
modifications in the actual file you edit but creates a copy of the file in the %userprofile%\AppData
\Local\VirtualStore folder.

From then on, programs that run without administrative credentials use the file in the VirtualStore
folder while those that run with administrative credentials use the actual xdb. ini file which can lead to
some confusing results.

Changing the Private XDB Server Configuration Files in Batch

The XDB Client Batch Options command, BOPT40N, is a batch version of the XDB Client Options utility,
XOPT40N.

You can use BOPT40N to modify the options in the xdb . ini file in batch. The syntax of the command is
as follows:
bopt40n /pSecti on.Vari abl e=Val ue

Where:

Section, Variable and Value indicate a section in xdb. ini, a variable in that section and the value you
want to set the variable to.

Note: If any of Section, Variable or Value include any spaces, you must use quotes around the entire
argument. In the following example, the connection name has an embedded space in the section
name so you need to use quotes around the entire argument in the command as follows:

bopt40n "/pConnection MYSERVER.CurrentLocation=MYLOC"
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Configuring Other Components

Micro Focus Rumba+ Desktop

To use Micro Focus Rumba+ Desktop on a TS/Citrix machine, ensure you install a license for this type of
environment. Contact Micro Focus Sales for more information.

ViewNow Installation

To use ViewNow on a TS/Citrix machine, ensure you install a license for this type of environment. Contact
Micro Focus Sales for more information.

After Installing

Installation

« See Changes in Behavior or Usage in your product documentation and in the Release Notes for
important information about changes in this release that might affect existing applications.

» Check the Product Documentation section of the Micro Focus SupportLine Web site for any updates to
the documentation which might have been uploaded.

Configuring Enterprise Developer

If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.
2. Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open
Perspective > Other.

From the Open Perspective dialog box, click the perspective you want to reset.
Click OK.

Click Window > Perspective > Reset Perspective.

When prompted, click Yes.

Reapply any customizations.

No o kow

On Windows

Installing X Windows on Windows

Some features of Enterprise Developer for Eclipse on Windows require an X Windows installation, hence
Micro Focus ViewNowX is provided with the product.

To install ViewNowX:

1. Using Windows Explorer, navigate to the folder that contains the ViewNowX executable. By default, this
is WProgramFiles(x86)%\Micro Focus\Enterprise Developer\ViewNowX.

2. Execute ViewNow_X_Server .exe and then vnx_HF_ 11327 .msp in that folder.

ViewNowX requires that your client machine has Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86) installed. If it is missing from your machine, the ViewNowX installation will offer a link to download the
package.


https://www.microfocus.com/support-and-services/documentation/

Repairing on Windows

If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.

2. Click Uninstall a program under Programs in Control Panel.

3. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product

directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Note: The installer creates separate installations for Micro Focus Enterprise Developer and Micro
Focus License Administration. Uninstalling only Enterprise Developer does not automatically uninstall
the Micro Focus License Administration or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

e The Micro Focus Product Narme folder in the Start menu - you can delete it manually.

« Y%systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log
files of the samples which you have built.

* %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.

 %Program Files%\Micro Focus - you can delete it manually.

To silently uninstall the product, you need the setup file and you need to execute the following at the

command line:

start /wait install-file.exe /Zquiet Zuninstall

In addition, the following registry entries are not removed. These are created the first time that an
Enterprise Server that has been enabled for performance monitoring starts up:

* Micro Focus Server\Performance\Active Servers
* Micro Focus Server\Performance\PerflniFile

On UNIX

Configuring the Remote System Explorer Support

Note: The following only applies if you are using Micro Focus Enterprise Developer UNIX
Components with Enterprise Developer for Eclipse.

The remote development support from the Eclipse IDE relies upon Enterprise Developer running on the
UNIX machine and handling all requests from the IDE for building and debugging programs. Enterprise
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Installation

Developer provides a UNIX daemon, the Remote Development Option (RDO) daemon, which initiates the
RDO as Eclipse clients connect to it. Whichever environment is used to start the RDO daemon will be
inherited for all servers and hence all build and debug sessions.

Configuring the Environment

You may need to configure some aspects of the environment before you start the daemon. This is because
when a build or debug session is initiated from one of the Eclipse clients, the environment used will be
inherited from whatever was used to start the daemon. A typical example of the kind of environment that
might need to be set up would include database locations and settings for SQL access at build/run time.

Starting the Daemon

/1. Important: Before starting the daemon you must have the following on your UNIX machine:

» A version of Perl.

» Aversion of Java 8 or later.

* The as (assembler) and Id (linking) programs on the path, as specified by the PATH environment
variable.

To start the daemon on the default port (4075) as a background process, perform this command with
superuser authority:
$COBDIR/remotedev/startrdodaemon

The daemon will now listen for any Eclipse client processes connecting to that machine on port 4075. If
you want to use another port, specify another port number on the startrdodaemon command.

The daemon can also be configured to instantiate the servers on a specified port or range of ports. This is
particularly relevant when you want to only open certain ports through a firewall. To do this, perform this
command with superuser authority:

$COBDIR/remotedev/startrdodaemon [<port> | <l ow port>-<hi gh port>]
where:

e <port> is the port number the daemon should use to listen for connections from Eclipse on the client
machine. If no value is given, it will be assigned a default value of 4075. This value matches the value
assigned within the Eclipse installation.

For example,
$COBDIR/remotedev/startrdodaemon 4999

This command will start a daemon listening on port 4999 and will use random server ports.
» <low port>-<high port> is the range of ports on which the servers (launched by the daemon) should use
to communicate with Eclipse on the client machine.

For example,
$COBDIR/remotedev/startrdodaemon 4080 4090-4999

This command will start a daemon listening on port 4080 and server ports will be in the range 4090 to
4999,

Stopping the Daemon

To stop the daemon, type the following command with superuser authority:
$COBDIR/remotedev/stoprdodaemon <port >
Repairing on UNIX

If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.



Uninstalling

Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstal l_EnterpriseDeveloper5.0.sh script in the $COBDIR/bin
directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the Unlnstal IMFLicenseServer .sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
i Note:

If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

» If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,
contact your sales representative or Micro Focus SupportLine.

To start Micro Focus License Administration

Windows

Windows 8.1 « From the Windows Start screen, click the License Administration tile

Windows 10 and Later .  From your windows desktop, click Start > Micro Focus License Manager >
License Administration

UNIX

Log on as root, and from a command prompt type:
/var/microfocuslicensing/bin/cesadmintool .sh

Installing licenses

You need either a license file (with a .mFlic extension) or an authorisation code which consists of a string
of 16 alphanumeric characters.

If you have a license file

Windows

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

* Click Browse next to the License file field and select the license file (which has an extension
of .mFlic).
» Drag and drop the license file from Windows Explorer to the License file field.
« Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file
into the box below the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

1. Start Enterprise Developer.
2. Click Help > Micro Focus > Product Licensing to open the Product Licensing dialog box.
3. Ensure | have a full Enterprise Developer Team Edition license is checked.
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4. Click Browse next to the License file field.
5. Select the license file (which has an extension of .mFlic), and then click Open.
6. Click Finish to install the license.

UNIX

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

If you have an authorization code

Authorizing your product when you have an Internet connection

i Note:

» Itis not possible to install licenses remotely. You must be logged into the machine on which you
are installing the licenses.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

Windows

1. Start Micro Focus License Administration.

2. Click the Install tab.

3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

UNIX

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection

This method of authorization is required if the machine you want to license does not have an Internet
connection or if normal (automatic) authorization fails.

Windows

1. Start Micro Focus License Administration.

2. Click Manual Authorization on the Install page.

3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

< If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

« If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.

Licensing Information

95



96

5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character
alphanumeric string supplied when you purchased your product.

Type the Machine ID in the Machine ID field.
Type your email address in the Email Address field.
Click Generate.

Copy the generated license string (or copy it from the email) and paste it into the box under the License
file field on the Install page.

10.Click Install Licenses.

© xo N

UNIX
In order to authorize your product you must have the following:

» Access to a computer which is connected to the Internet.
* Your authorization code (a 16-character alphanumeric string).

* The machine ID. To get this, start the Micro Focus License Administration tool and select the Get
Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

Click Generate.

Copy the licenses strings from the web page or the email you receive into a file.

Put the license file onto your target machine.

Start the Micro Focus License Administration tool and select the Manual License Installation option by
inputting 4.

7. Enter the name and location of the license file.

o gk w

To obtain more licenses

If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or Micro Focus SupportLine.

Licensing Information
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Updates and SupportLine

Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support

Additional technical information or advice is available from several sources.
The product support pages contain a considerable amount of additional information, such as:

« The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates. Go to https://supportline.microfocus.com/websync/
productupdatessearch.aspx

e The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation. Go to https://supportline.microfocus.com/examplesandutilities/
index.aspx.

« The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident. Go to https://supportline.microfocus.com/
supportresources.aspx

To connect, enter https://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support & Services > Support > Support Resources > All Support Resources by Product. In the
Browse by Product field, click the product you require, and then click Log into SupportLine.

i Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, https://www.microfocus.com/support-and-services/contact-support/. If you obtained the product from
another source, such as an authorized distributor, contact them for help first. If they are unable to help,
contact us.

Also, visit:

e The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See https://community.microfocus.com.

* The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusintl.

Information We Need

However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

* The name and version number of all products that you think might be causing a problem.

e Your computer make and model.

« Your operating system version number and details of any networking software you are using.
e The amount of memory in your computer.

« The relevant page reference or section in the documentation.

* Your serial number. To find out these numbers, look in the subject line and body of your Electronic
Product Delivery Notice email that you received from Micro Focus.
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On Windows, if you are reporting a protection violation you might be asked to provide a dump ( -dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportinfo, to create
either:

e a . logfile that contains the details about your environment, Micro Focus SupportLine products, and
settings.

e a .zip archive that includes the same information as the . 1og file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportinfo.exe is stored in <i nstal | - di r >\bin.
To run MFSupportinfo:

1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a . log file or a .zip archive as follows:

a. To create a . log file, click File > Save.

This prompts to save the . 1og file, MFSupportinfo_Log_Machi neNane_YYYY-MM-DD_HH-MW-
SS.1og, in the %temp% directory.
b. To create a .zip archive, click Tools > Create Zip Package.

This creates a .zip archive, MFSupportinfo_Log_ Machi neNane_YYYY-MW-DD_HH-MW-
SS.zip, in the %temp% directory.
4. Send the diagnostic information to your Micro Focus SupportLine representative:

The following requires an Internet connection and an Email client:

a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.

If the machine is not connected to the Internet or if there are no Email clients installed, copy either

the . log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mFsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.

To run mFsupport:

1. Start a UNIX shell.
2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.

This creates a log file, mfpol I . txt, in that directory.
4. When the script finishes, send the mfpol I . txt file to your Micro Focus SupportLine representative.
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i Note:

If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of Zopt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.

If COBDIR is set to a location that does not contain etc/cobver or COBDIR is not set, mfsupport
gives you the option to search your machine for possible product locations. Note that the search can
take some time if you have a large amount of disc storage and files.

Creating Debug Files

If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Copyright and Disclaimer

© Copyright 2019 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS 1S" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control
over and is not responsible for information on third party sites.

This product includes software developed by Computing Services at Carnegie Mellon University (http://
www.cmu.edu/computing/).
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